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Programming in JScript
JScript functionality in Intellect

The JScript programming language is used in Intellect to implement additional user functions not included in the basic Intellect functionality.

JScript is a de-facto standard for developing and running user scripts. Intellect supports the version of JScript based on ActiveX technology by Microsoft. The general description of the
JScript object model is given in the Microsoft documentation (for example, MSDN).

The JScript scripts in Intellect are executed using the standard ActiveX modules included in the Windows operating system. So, any objects from the ActiveX-based JScript can be used
in developing the scripts for Intellect.

A set of specialized JScript objects is provided in Intellect for handling Intellect system objects, and for sending and receiving system events and actions.

Description of the JScript object model in Intellect

The Core object and its built-in methods
The Core object

The Core object is a global static object providing the methods for monitoring and controlling the Intellect system objects. Core methods allow receiving information about the existing
objects, generating reactions for them and changing their states. Core methods can pause script execution, script debugging, creating and calling global variables.

The Core object is not a prototype, thus no other objects can be created on its base (it cannot be used as a template). All Core methods are static. Thus, Core methods are called
directly from the script with no need for a Core prefix.

The SetObjectParam method

The SetObjectParam method sets the values of object parameters.

Method call syntax

function SetObjectParam(objtype: String, id: String, param : String, value : String)

Method arguments:

1. objtype - required argument. The type of the object whose parameters are to be set. It takes the following values: Type - String, range - existing object types.

2. id - required argument. Identification number of the object of the type set in the objtype parameter. It takes the following values: Type - String, range - existing object
identification numbers of the specified type.

3. param - required argument. The parameter of the object. It takes the following values: Type - String, range — available parameters of the object.

4. value - required argument. The value to be set for the parameter specified in the param argument. It takes the following values: Type - String, range — depends on the
parameter.

Usage examples

Example. When Macro 1 starts, check if Cameras 1 to 4 are set to broadcast color video. If a camera is set for black-and-white video broadcast, then switch it to the color mode (setting
the true (“1”) value to the “Color” parameter - (“color”)).



if (Event.SourceType == "MACRO" && Event.Sourceld == "1" && Event.Action == "RUN")

{
var i;
for(i=1; i<=4; i=i+1)
{
if (GetObjectParam("CAM", i, "color") == "0")
{
SetObjectParam("CAM", i, "color", "1");
b
b
¥
Note

If the object is active when the script is started (i.e. the setting panel of this object is open), then object parameters can not be changed by the SetObjectParam method. For
instance, if the setting panel for the Camera 1 object is open and the aforecited script is started, the operation mode of Camera 1 will not be changed for the color one.

The SetObjectState method

The SetObjectState method changes the state of objects.

Method call syntax

function SetObjectState(objtype : String, id : String, state : String)

Method arguments:

1. objtype - Required argument. The type of the object whose state is to be changed. It takes the following values: Type - String, range - existing object types.
2. id - Required argument. Identification number of the object of the type set in the objtype parameter. It takes the following values: Type - String, range — existing object

identification numbers of the specified type.
3. state - Required argument. The state to switch the object to. It takes the following values: Type - String, range - available states of the object.

Usage examples
Example. Check if Camera 1 is armed every hour. If Camera 1 is disarmed, arm it.

Note
The Timer object with identification number 1 should be created beforehand. Set the Minutes parameter of the Timer object to 30.The timer would go off every hour at half

past the hour - 09:30, 10:30, 11:30, etc.



if (Event.SourceType == "TIMER" && Event.Sourceld == "1" && Event.Action == "TRIGGER")

{
if (GetObjectState("CAM", "1") == "DISARMED")
{
SetObjectState("CAM", "1", "ARMED");
b
h:

The DebuglLogString method
The DebuglLogString method outputs the user messages into the debug windows of the Editor-Debugger utility.

Method call syntax

function DebuglLogString(output : String)

Method arguments:

output - Required argument. The text message to be displayed in the debug window of the Editor-Debugger utility. It takes the following values: Type - String.

Usage examples

Problem. Output to the debugger window all microphone events registered by the system.

if (Event.SourceType == "OLXA_LINE")

{
var msgstr = Event.MsgToString();

DebuglLogString("Event from the microphone " + msgstr);

b

The Base64Decode method

The Base64Decode method is used for decoding the lines that are coded by Base64 scheme.

Method call syntax

function Base64Decode(data_in: String, WideChar: Boolean)



Method arguments:

1. data_in - required argument. Set a line that should be decoded in Base64;
2. WideChar - required argument. Determines coding type. Can take 0 or 1 values. If coding type is Unicode, argument value is 1, otherwise 0.

Usage examples

Decode the line that is set in Base64 by starting macro N21. Output the decoding result into the debug windows of the Editor-Debugger utility. (Result is « Intellect JAVA SCRIPT» line).

if (Event.SourceType == "MACRO" && Event.Sourceld == "1" && Event.Action == "RUN")

{
var str = Base64Decode("SW50ZWxsZWNOIEpTY3]lpcHQ= ", 0);

DebuglLogString(str);

The Sleep method

The Sleep method pauses the execution of the script for a specified period of time.

Method call syntax

function Sleep(milliseconds : int)

Method arguments:

milliseconds - Required argument. The length of time that the script will be inactive for. Set in milliseconds. It takes the following values: Type - int.

Usage examples

Problem 1. When Macro 1 starts, play the following audio files one by one: cam_alarm_1.wav, cam_alarm_2.wav, cam_alarm_3.wav from the ...\Intellect\Wav\ folder. Set a 5 seconds
(5000 milliseconds) delay before starting each subsequent file.

if (Event.SourceType == "MACRO" && Event.Sourceld == "1" && Event.Action == "RUN")
{
vari;
for(i=1; i<=3; i=i+1)
{
DoReactStr("PLAYER", "1", "PLAY_WAV", " file<\cam_alarm_" + i + ".wav>");
Sleep(5000);
b

b



Problem 2. When macro N22 starts, timer N21, that triggers every 10 seconds in a minute after macro N22 starting, starts.

Note
To start this script create the Timer object with ID=1 beforehand. Leave object parameters set by default (Any). The Timer 1 object can be disabled

if (Event.SourceType == "MACRO" && Event.Sourceld == "2" && Event.Action == "RUN")
{

for(i=0; i<=5; i=i+1)

{

DoReactStr("TIMER","1", "DISABLE", "");

Sleep(10000);

DoReactStr("TIMER","1", "ENABLE", "");

NOtifYEVentStr("TIMER","1", "TRIGGER“, IIII);

b
DoReactStr("TIMER","1", "DISABLE", "");

b

The Itv_var method

The Itv_var method sets and returns the values of global variables.

Method call syntax

function Itv_var (globalvar : String) : String

Method arguments:

globalvar - Required argument. The name of the global variable. It takes the following values: Type - String, satisfying the rules for the names of the string parameters in the
Windows registry.

Global variables are stored in the Windows registry to maintain their values after Windows restart. All global variables are stored in the registry branch
HKEY_USERS\S-1-5-21-..\Software\ITVScript\ITVSCRIPT and HKEY_CURRENT_USER\Software\ITVScript\ ITVSCRIPT. To access a global variable directly from the registry, search the
registry for it by its name.

Usage examples

Problem. When Macro 1 starts, save the value of the bright parameter of Camera 10 to the cam10bright global variable. When Macro 2 starts, set the bright parameter of Cameras 1 to
4 to the value of the cam10bright global variable.



if (Event.SourceType == "MACRO" && Event.Action == "RUN")

{
if(Event.Sourceld == "1")
{
Itv_var("cam10bright") = GetObjectParam("CAM", "10", "bright");
b
if (Event.Sourceld == "2")
{
var cam10bright = Itv_var("cam10bright");
for(i=1; i<=4; i=i+1)
{
SetObjectParam("CAM", i, "bright", cam10bright);
b
b
b

The Int_var method

The Int_var method sets and returns values of global variables of integer type.

1 Attention!
The Int_var method uses the same storage as the Itv_var method, but modify the type of variable to the integer type.

Method call syntax:

function Int_var (globalvar : String) : int

Method arguments:
1. globalvar - required argument. The name of the global variable. It takes the following values: type - String, satisfying the rules for the names of the string parameters in the
Windows registry.

Note.
(D Global variables are stored in the system registry to maintain their values after Windows restart. All global variables are stored in the registry branch

HKEY_USERS\S-1-5-21-..\Software\ITVScript\ITVSCRIPT and HKEY_CURRENT_USER\Software\ITVScript\ ITVSCRIPT. To access a global variable directly from the registry,
search the registry for it by the same name.

Usage examples. To check the method operation in the following test example the value 1 sets to the "2" global variable and then increases per 1 and displays on the script debug
window.

10
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if(Event.Action =="RUN")
{
Int_var(2) = 1;
Int_var("2")++;
DebuglLogString(Int_var("2").toString());
b

The GetObjectParentType method

The GetObjectParentType method returns the type of the parent object of the current object according to the object hierarchy.

Method call syntax

function GetObjectParentType (objtype : String) : String

Method arguments:

objtype - Required argument. The type of the object whose parent’s type should be returned. It takes the following values: Type - String, range - existing object types.
The Main object is the highest level object in the hierarchy. It is the parent for all objects of the Computer, Screen, and other types.

Usage examples

Problem. When Macro 1 starts, display in the debugger window the names of four object types of higher hierarchical order starting from the detection zone.

if (Event.SourceType == "MACRO" && Event.Sourceld == "1" && Event.Action == "RUN")
{
var objtype = "CAM_ZONE";
DebuglLogString(objtype);
for(vari = 1; i<=4; i=i+1)
{
objtype = GetObjectParentType(objtype);
DebuglLogString(objtype);
b
b

The GetIPAddress method

The GetIPAddress method returns the IP-address of the Intellect kernel according to current video surveillance system architecture.
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Method call syntax

function GetIPAddress (dst : String, src : String) : String

Method arguments:

1. dst - Required argument. The name of the remote computer where the Intellect kernel is installed. The value of dst should correspond to one of the names of the computers
registered during setup of the video surveillance system. It takes the following values: Type - String, meeting the requirements for network computer names; range -
computer names existing in the system.

2. src - Required argument. The name of the local computer where the script executes. The value of src should match the name of the local computer as it is registered in
Intellect. It takes the following values: Type - String; meeting the requirements for network computer names.

The information about all connections of the local computer (kernel) to other remote computers (kernels) registered during the setup of the distributed architecture, is displayed in the
Architecture tab of the System Settings window.

Usage examples

Problem. Upon a camera alarm, determine the name of the server this camera is connected to, and output the IP-address of the connection between this server and the local computer
where the script executes, to the debugger window.

if (Event.SourceType == "CAM" && Event.Action == "MD_START")
{

var camid = Event.Sourceld;

var compname = GetObjectParentId("CAM", camid, "COMPUTER");

var ip = GetIPAddress("WS1","WS1"); \\if the script is run on the computer where kernel of Intellect software has been installed
DebuglLogString("IP-address of the alarmed camera computer" + ip);

b

The GetObjectName method

The GetObjectName method returns the name of the object that it was given upon creation.

Method call syntax

function GetObjectName(objtype : String, id : String) : String

Method arguments:

1. objtype - Required argument. The type of the object whose name is to be returned. It takes the following values: Type - String, range - existing object types.
2. id - Required argument. Identification number of the object of the type set in the objtype parameter. It takes the following values: Type - String, range - existing object
identification numbers of the specified type.

Usage examples
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Problem. In case of alarm in any sensor, open the information window with the following text - "Alarm in the <alarmed sensor name> sensor connected to the <server name which the
sensor is connected to> server”.

@ Note

Create the information dialog window beforehand using the Arpedit.exe utility and save it as test.dlg in the <Intellect>\Program folder.

if (Event.SourceType == "GRAY" && Event.Action == "ALARM")
{

var grayid = Event.Sourceld;

var grayname = GetObjectName("GRAY", grayid);

var compname = GetObjectParentId("GRAY", grayid, "COMPUTER");

DoReactStr("DIALOG", "test", "CLOSE_ALL","");

DoReactStr("DIALOG", "test", "RUN","Alarm in the *" + grayname + "’ sensor connected to the " + compname +

nr

server.");

The GetObjectState method

The GetObjectState method returns the state of the object at the moment of method call.

Method call syntax

function GetObjectState(objtype : String, id : String) : String

Method arguments:

1. objtype - Required argument. The type of the object whose state is to be returned. It takes the following values: Type - String, range - existing object types.
2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the objects of the specified type.

Usage examples

Problem. When Relay 1 activates (for example, on pressing the button connected to Relay 1), arm Sensor 1. The next time Relay 1 activates, disarm Sensor 1.
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if (Event.SourceType == "GRELE" && Event.Sourceld == "1" && Event.Action == "ON")

{
if(GetObjectState("GRAY", "1")=="DISARM")
{
SetObjectState("GRAY", "1", "ARM");
b
else
{
SetObjectState("GRAY", "1", "DISARM");
b
h:

The GetObjectParam method

The GetObjectParam method returns the value of the specified parameter of the object at the moment of method call.

Method call syntax

function GetObjectParam(objtype : String, id : String, param : String) : String

Method arguments:

1. objtype - Required argument. The type of the object whose parameter’s value is to be returned. It takes the following values: Type - String, range — existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the objects of the specified type.

3. param - Required argument. The name of the parameter whose value is to be returned. It takes the following values: Type - String, range — available parameters of the
object.

Usage examples

See the example for the SetObjectParam method.

The GetObjectParentld method

The GetObjectParentld method returns the identification number of the parent of the specified object.

Method call syntax

function GetObjectParentld(objtype : String, id : String, parent : String) : String

Method arguments:



15

1. objtype - Required argument. The type of the object whose parent’s identification number should be returned. It takes the following values: Type - String, range - existing
object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the objects of the specified type.

3. parent - Required argument. The type of the object which is the parent of the object type specified by the objtype argument. It takes the following values: Type - String,
range - existing object types.

Usage examples

Problem. If a camera turns off or stops transmitting a video signal, send an e-mail message with the following subject: "Warning! Camera turned off" and, in the message body, the
number of the camera and of the server it is connected to.

@ Note

The Short Messages Service is supposed to be installed and working properly

if ((Event.SourceType == "CAM" && Event.Action == "DETACH") || (Event.Action == "REC_STOP"))
{

var cam_id = Event.Sourceld;

var parent_comp_id = GetObjectParentld("CAM", cam_id, "COMPUTER");

DoReactStr("MAIL_MESSAGE","1","SETUP","from<***@mail.ru>,to<***@mail.ru>,body<Camera disabling "+cam_id+" on the
Server"+parent_comp_id+">,parent_id<1>,subject<Attention! Camera disabling>,name<Message 1>,o0bjname<Message 1>");

DoReactStr("MAIL_MESSAGE", "1", "SEND", "");

b

The DoReactStr method

The DoReactStr method generates the response actions for the objects. It sends the action to the specified object. The action is transferred directly to the kernel where the object
belongs, and not to the whole system. The action is specified as a group of String arguments.

Method call syntax

function DoReactStr(objtype : String, id : String, action : String, param<value> [, param<value>] : String)

Method arguments:

1. objtype - Required argument. The type of the object that the action should be generated for. It takes the following values: Type - String, range — existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the objects of the specified type.

3. action - Required argument. The action to be generated. It takes the following values: Type - String, range — available actions for the objects of the specified type.

4. param<value> - Required argument. Several arguments of this type can be specified. The parameters of the action.

One parameter has the following syntax:



"param<value>", where

param - name of the parameter;

value - value of the parameter.

Several parameters have the following syntax:
"paraml<valuel>,param2<value2>.."

Elements of the list are separated by commas with no white space. If no parameters need to be specified, an empty string is used:

DoReactStr("CAM","1","REC","");

The param argument can take the following values: Type — String, range - available parameters of the specified action. The value argument can take the following values: Type -
String, range - depends on the parameter.

For all reactions it is possible to specify delay of reaction performing using delay<> parameter. Delay is specified in seconds.

Note
Two types of system messages are available in the Intellect system: events and actions.

The events usually contain some information and are used as notifications sent to all Intellect kernels connected to each other during the system setup.
The actions are the control commands sent to specific objects. An action is transmitted only to the kernel where the related object belongs, and not to the whole system.

The DoReactStr and DoReact methods are used to generate actions. The NotifyEventStr and NotifyEvent methods are used to generate events.

Usage examples

Problem. When an alarm is received from a camera, switch Monitor 1 to single window mode and show the video from the alarmed camera in this window.

if (Event.SourceType == "CAM" && Event.Action == "MD_START")
{

var camid = Event.Sourceld;
DoReactStr("MONITOR","1","ACTIVATE_CAM","cam<"+ camid +">");
DoReactStr("MONITOR","1","KEY_PRESSED","key<SCREEN.1>");

b

Problem. When alarm by some camera is completed the record is to be continued for 5 second and after this time the record will be stopped (analogue of Post-record mode).
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if (Event.SourceType == "CAM" && Event.Action == "MD_STOP")
{
var camid = Event.Sourceld;
DoReactStr("CAM",camid,"REC_STOP","delay<5>");

b

Problem. Use macros 1 to enable telemetry control using mouse on the camera 4 displayed in the monitor 10. Use macros 2 to disable it.

17

if (Event.SourceType == "MACRO" && Event.Action == "RUN" && Event.Sourceld == "1")
{ DoReactStr("MONITOR","10","CONTROL_TELEMETRY","cam<4>,on<1>");
iz:’(Event.SourceType == "MACRO" && Event.Action == "RUN" && Event.Sourceld == "2")
{ DoReactStr("MONITOR","10","CONTROL_TELEMETRY","cam<4>,0n<0>");

¥

The DoReact method

The DoReact method generates actions for the objects. It sends the action to the specified object. The action is transferred directly to the kernel where the object belongs, and not to
the whole system. The action is specified using the MsgObject object.

Method call syntax

function DoReact(msgevent : MsgObject)

Method arguments:
msgevent - Required argument. The action sent to the specified object. It takes the following values: MsgObject objects created earlier in the script.
Note
Two types of system messages are available in the Intellect system: events and actions.
The events usually contain some information and are used as notifications sent to all Intellect kernels connected to each other during the system setup.
The actions are the control commands sent to specific objects. An action is transmitted only to the kernel where the related object belongs, and not to the whole system.

The DoReactStr and DoReact methods are used to generate actions. The NotifyEventStr and NotifyEvent methods are used to generate events.



Usage examples

Problem. When Relay 1 closes, close Relays 2 and 3. When Relay 1 opens, open Relay 2.

if (Event.SourceType == "GRELE" && Event.Sourceld == "1")
{

var msgevent = Event.Clone();

if(Event.Action == "ON")

{
msgevent.Sourceld = "2";
DoReact(msgevent);
msgevent.Sourceld = "3";
DoReact(msgevent);

b

if(Event.Action == "OFF")

{
msgevent.Sourceld = "2";
DoReact(msgevent);

b

¥

The DoReactSetupCore method
The DoReactSetupCore method is used for changing the parameters of the object. It changes only the specified parameters, leaving other parameters intact.

Method call syntax

function DoReactSetupCore(objtype : String, id : String, param<value> [, param<value>] : String )

Method arguments

1. objtype - Required argument. The type of the object whose parameters are to be changed. It takes the following values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the object of the specified type.

3. param<value> - Required argument. Several arguments of this type can be specified. The parameters of the action.

One parameter has the following syntax:
“param<value>", where
param - name of the parameter;

value - value of the parameter.



Several parameters have the following syntax:
“paraml<valuel>,param2<value2>..".

Elements of the list are separated by commas with no white space.

The param argument can take the following values: Type - String, range - available parameters of the specified action. The value argument can take the following values: Type -
String, range - depends on the parameter.

Usage examples

Problem. When Macro 1 starts, set the values of the following parameters of Cameras N21-4: PTZ device number (telemetry_id) and synchronous microphone number (audio_id). The
values should be equal to the camera numbers plus 1.

if (Event.SourceType == "MACRO" && Event.Sourceld == "1" && Event.Action == "RUN")
{

var i;

for(i=1; i<=4; i=i+1)

{

DoReactSetupCore ("CAM", i, "telemetry_id<" + (i+1) +">,audio_id<" + (i+1) + ">");

b
¥

The DoReactSetup method
The DoReactSetup method is used for temporary changing parameters of the object. It changes only the specified parameters, leaving other parameters intact.

Method call syntax

function DoReactSetup (objtype : String, id : String, param<value> [, param<value>] : String )

Method arguments:

1. objtype - required argument. The type of the object the parameters of which are to be changed. It takes the following values: type - String, range - existing object types.
2. id - required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: type - String, range - existing identification

numbers of the objects of the specified type.
3. param<value> - required argument. Several arguments of this type can be specified. The parameters of the action.

One parameter has the following syntax:
“param<value>", where

param - name of the parameter;

value - value of the parameter.

Several parameters have the following syntax:
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“paraml<valuel>, param2<value2>...".
Elements of the list are separated by commas with no white space.

The param argument can take the following values: values of the String type, range is limited by available parameters of the specified action. The “value” argument can take the
following values: values of the String type, the range depends on the parameter.

Example. When Macro 1 starts, temporary remove all cameras on the first monitor.

if (Event.SourceType == "MACRO" && Event.Sourceld == "1" && Event.Action == "RUN")
{

DoReactSetup ("MONITOR","1","REMOVE_ALL","");

b

The DoReactGlobal method

The DoReactGlobal method is used to generate object reactions. The DoReactGlobal method transmits a reaction to the required object. The reaction is transmitted not only to the
kernel, where the object is registered, but to the whole system. For the DoReactGlobal method the reaction is specified by the MsgObject object.

Method call syntax

function DoReactGlobal(msgevent : MsgObject)

Method arguments:

msgevent - required argument. It sets a reaction transmitted to the required object. It takes the following values: MsgObject objects created earlier in the script.

Example. When macro 2 starts, guard on Sensor 2. The command is to be transmitted to all system kernels as the reaction to be registered in the Events Log.

if (Event.SourceType == "MACRO"&& Event.Sourceld == "2" && Event.Action == "RUN")
{

var msgevent = CreateMsg();

msgevent.SourceType = "GRAY";

msgevent.Sourceld = "2";

msgevent.Action = "ARM";

DoReactGlobal(msgevent);

b

The NotifyEventStr method

The NotifyEventStr method generates system events. Events are sent to all kernels connected to the local kernel. An event is specified as a group of String arguments.
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Method call syntax

function NotifyEventStr(objtype : String, id : String, event : String, param<value> [, param<value>] : String )

Method arguments:

1. objtype - Required argument. The type of the object that the event should be generated for. It It takes the following values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the object of the specified type.

3. event - Required argument. The event to be generated. It takes the following values: Type - String, range - available events for the objects of the specified type.

4. param<value> - Required argument. Several arguments of this type can be specified. The parameters of the event.

One parameter has the following syntax:
"param<value>", where

param - name of the parameter;

value - value of the parameter.

Several parameters have the following syntax:
"paraml<valuel>,param2<value2>..".

Elements of the list are separated by commas with no white space. If no parameters need to be specified, an empty string is used:

DoReactStr("CAM","1","MD_START","");

The param argument can take the following values: Type — String, range - available parameters of the event. The value argument can take the following values: Type - String, range -
depends on the parameter.

Note

Two types of system messages are available in the Intellect system: events and actions.

The events usually contain some information and are used as notifications sent to all Intellect kernels connected to each other during the system setup.

The actions are the control commands sent to specific objects. An action is transmitted only to the kernel where the related object belongs, and not to the whole system.

The DoReactStr and DoReact methods are used to generate actions. The NotifyEventStr and NotifyEvent methods are used to generate events.
Usage examples

Problem. When an alarm is received, send the “panic lock” event corresponding to the camera region. For camera identification numbers from 1 to 4, use region 1; for camera numbers
from 5 to 10, use region 2.
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if (Event.SourceType == "CAM" && Event.Action == "MD_START")
{

var regionid;

if (Event.Sourceld <=4)

{
regionid = "1";
b
if ((Event.Sourceld > 4) && (Event.Sourceld <= 10))
{
regionid = "2";
b
NotifyEventStr("REGION", regionid, "PANIC_LOCK", "");
b

The NotifyEvent method

The NotifyEvent method generates system events. The event is sent to all kernels connected to the local kernel. The event is specified using the MsgObject object.

Method call syntax

function NotifyEvent(msgevent : MsgObject)

Method arguments:
msgevent - Required argument. The event sent to the system. It takes the following values: MsgObject objects created earlier in the script.
(D Note

Two types of system messages are available in Intellect system: events and reactions.
The events usually contain some information and are used as notifications sent to all Intellect kernels connected to each other during the system configuration.
The reactions are the control commands sent to specific objects.
The reactions are transmitted only to the kernel where the object belongs, and not to the whole system.
The DoReactStr and DoReact methods are used to generate reactions. The NotifyEventStr and NotifyEvent methods are used to generate events.

Example. When the Backup Archive 1 module starts archiving video recordings, the analog output 1 of the Video Capture Device 2 is disabled. Send the command as an event to be
registered in the Events Log.

(T) Note
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While executing this script, the analog output 1 of the Video Capture Device 2 is not disabled

if (Event.SourceType == "ARCH" && Event.Sourceld == "1" && Event.Action == "ACTIVE ")
{

var msgevent = CreateMsg();
msgevent.SourceType = " GRABBER ";
msgevent.Sourceld = "2";
msgevent.Action = "MUX1_OFF";
NotifyEvent(msgevent);

The NotifyEventGlobal method

The NotifyEventGlobal method is used to generate system events. The generated event is transmitted to all system kernels connected via the net. For the NotifyEventGlobal method the
event is specified using the MsgObject object.

Method call syntax

function NotifyEventGlobal (msgevent : MsgObject)

Method arguments:
msgevent - required argument. It sets the event transmitted to the system. It takes the following values: MsgObject objects created earlier in the script.

Example. When Macro 1 starts, the first camera is set for recording. The command is to be transmitted to all system kernels as the event to be registered in the Events Log.

Note
While executing this script, cameral is not set for recording.

if (Event.SourceType == "MACRO"&& Event.Sourceld == "1" && Event.Action == "RUN")
{

var msgevent = CreateMsg();

msgevent.SourceType = "CAM";

msgevent.Sourceld = "1";

msgevent.Action = "REC";

NotifyEventGlobal(msgevent);

b



The CreateMsg method

The CreateMsg method creates objects based on the MsgObject prototype.

Method call syntax

function CreateMsg() : MsgObject

Method arguments: no arguments.
Usage examples

Problem 1. When an alarm is received, send the “panic lock” event corresponding to the camera region. For camera identification numbers from 1 to 4, use region 1, for camera
numbers from 5 to 10, use region 2.

if (Event.SourceType == "CAM" && Event.Action == "MD_START")
{

var msgevent = CreateMsg();

msgevent.SourceType = "REGION";

msgevent.Action = "PANIC_LOCK";

if (Event.Sourceld <=4)

{msgevent.SourceId ="1"

i}f((Event.SourceId > 4) && (Event.Sourceld < 10))
{msgevent.SourceId ="2"

&otinyvent(msgevent);

Problem 2. When timer N91 starts, start macro N21 every 30 seconds.

(D Note

To start this script create the Timer object with ID=1 beforehand. Set value=1 to the Second parameter of the Timer object, leave other parameters without changing («An
y by default)



if (Event.SourceType == "TIMER" && Event.Sourceld == "1" && Event.Action == "TRIGGER")

{

var msg = CreateMsg();

msg.StringToMsg(GetObjectParams("TIMER", "1"));

if(msg.GetParam("s") == "1")

{

DoReactStr("MACRQ", "1", "RUN", "");

SetObjeCtParam(“TIMER",”1",“5","30”);

DoReactStr("TIMER","1", "DISABLE", "");

DoReactStr("TIMER","1", "ENABLE", "");

b

if(msg.GetParam("s") == "30")

{

DOReaCtStI’("MACRO", ||1||’ "RUN", llll);
SetObjECtPar‘am("TIMER","1","5","1");

DoReactStr("TIMER","1", "DISABLE", "");

DoReactStr("TIMER","1", "ENABLE", "");

b

¥

The Lock and Unlock methods

The Lock and Unlock methods are used to create a global critical section when synchronization of scripts started in different streams is required. The Lock method opens a critical
section and the Unlock method closes it.

i Attention!
Attention! If the Lock method has been called, then the Unlock method has to be called too. Otherwise the system can freeze.

It is recommended to avoid using the Lock and Unlock methods.

Method call syntax

function Lock()
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function Unlock()

Example. When Macro 1 starts, calculate total alarmed relays and sensors. Objects of each type are to be calculated at the same time (in an individual script). The result is to be stored
to “counter” global variable.

Script 1:

// Number of alarmed relays is calculated

var i = Number(0);

if (Event.SourceType == "MACRO" && Event.Sourceld== "1" && Event.Action == "RUN")

{

var msg = CreateMsg();

msg.StringToMsg(GetObjectlds("GRELE"));

var objCount = msg.GetParam("id.count");

var k;

for(k= 0; k < objCount; k++)

if(GetObjectState("GRELE", msg.GetParam("id." + k))== "ALARM"){
Lock();
i = Itv_var("counter");

i++;

Itv_var("counter")=i;

Unlock();

b

¥

Script 2:
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//Number of alarmed sensors is calculated
var i = Number(0);

i
{

\Y

f (Event.SourceType == "MACRO" && Event.Sourceld== "1" && Event.Action == "RUN")

ar msg = CreateMsg();

msg.StringToMsg(GetObjectlds("GRAY"));

\
Vv

ar objCount = msg.GetParam("id.count");
ar k;

for(k = 0; k < objCount; k++)
if(GetObjectState("GRAY", msg.GetParam("id." + k))== "ALARMED"){

Lock();
i = Itv_var("counter");
i++;
Itv_var("counter")=i;
Unlock();
¥
b

(D Note

If the Lock() and Unlock() methods are not used in this example, then collisions may occur and calculated value will be less than a real one

The IsAvailableObject method

The IsAvailableObject method is used to determine the current access rights to an object.

Method call syntax:

function IsAvailableObject(compname: String, objtype: String, id: String, param : String) : String

The method returns 0 if the current user has not been assigned access rights of type param for the object; it returns 1 if these rights have been assigned.

Method arguments:

1.
2.

3.

compname - required. Corresponds to the name of the Computer object on which the object was created in the hardware tree.
objtype - required. Corresponds to the type of the system object to which access rights are are being checked. Allowed values: String type; the set of values is restricted to the
object types registered in the system.
id - required. Corresponds to the identification (registration) number of the object of the type specified by the objtype argument. Allowed values: String type; the set of values
is restricted to the identification numbers of objects of the specified type, which are registered in the system.
param - required. Corresponds to the number of the type of rights which are being checked. A description of rights is given in Limiting access to the administration of the
system objects, control and viewing functions of the Administrator’s Guide. Allowed values:

a. 0 - NoView access rights. The method will return 1 if there are no administrative, control-, or viewing rights for the object (red 'x').


https://doc.axxonsoft.com/confluence/display/Int411en/Limiting+access+to+the+administration+of+the+system+objects%2C+control+and+viewing+functions
https://doc.axxonsoft.com/confluence/display/Int411en/Limiting+access+to+the+administration+of+the+system+objects%2C+control+and+viewing+functions
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=136250443
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1 - NoControl access rights. The method will return 1 if there are only viewing rights (letter M).

2 - ViewAndControl access rights. The method will return 1 if there are control- and viewing rights for the object (green box).

3 - ViewOrControl access rights. The method will return 1 if there is either viewing or control rights for the object.

4 - Not access rights (e.g. no access rights).

5 - Configure access rights. The method will return 1 if there are administrative, control- and viewing rights for the object (gray box).

NNl

For example: Based on a Computer object named "S-UYUTOVA", a Camera object with the identifier 1 has been created in the hardware tree. To determine the current access rights
to the object:

vari = 0;

for(i=0; i <=5; i++)

{
var result =
IsAvailableObject('S-UYUTOVA','CAM','1", i);
DebuglLogString("right "+i+" = "4+result);

b

The GetUserld method

The GetUserld method returns the identifier of the current Intellect Software System user.

Method call syntax:

function GetUserId (cmp : String) : String

Method arguments:

1. cmp - required. Specifies the name of the computer on which the Intellect Software System is installed. Allowed values: values of String type that satisfy the requirements for
computers' network names; the set of values is restricted to the names of computers registered in the system.

For example: To display the identifier of the current user of the Intellect Software System, which has been installed on a computer named 'WS3":

DebuglLogString(GetUserId("WS3"));



The GetEventDescription method

The GetEventDescription method is in use for receiving the object description on free language.

Syntax of method invocation:

function GetEventDescription (obj_type : String, event : String)

Method arguments:

1. obj_type - required argument. Specifies type of system object description of which is required to get.
2. event - required argument. Specifies the name of object description of which is required to get.
Example. Display messages about receiving of events for camera 1 on the free language in the Debug window.

if (Event.SourceType == "CAM"&& Event.Sourceld == "1")
{

var str = GetEventDescription("CAM", Event.Action);
DebuglLogString(str);
b

The GetObjectldByParam method

The GetObjectIdByParam method allows receiving of object ID at which some parameter is equal to the specified value. The first found object ID is receiving if there are several such
objects. The null is receiving if such objects are not found

Syntax of method invocation:

function GetObjectldByParam (obj_type : String, obj_param : String, param_value : String)

Method arguments:

1. obj_type - required argument. Specifies type of system object, ID of which is required to get.
2. obj_param - required argument. Specifies the name of parameter in database on value of which the object is to be found.

3. param_value - required argument. Specifies the required value of object parameter.

Example. Find cameras from which black-and-white image is receiving and set the Color parameter equals to 1 for them.
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if (Event.SourceType == "MACRO" && Event.Sourceld== "1" && Event.Action == "RUN")

{
var id = GetObjectldByParam("CAM","color","0"); //receiving the first object ID
while (id){ //while exist the Camera objects from which black-and-white image is receiving
SetObjectParam ("CAM", id, "color", "1"); //change the Color parameter for found object
id = GetObjectIdByParam("CAM","color","0"); //receiving the next object ID
b
b

The SaveToFile method

SaveToFile method is in use to save in file the frame from camera receiving in the data parameter of FRAME_SENT event.

Syntax of method invocation:

function SaveToFile (path: String, data: String, param : Boolean)

Saving of frame is also can be performed using the GET_FRAME reaction of the CAM object. It is required to specify the path for saving file with frame in the path parameter of this
reaction. FRAME_SENT event is created in the system if the GET_FRAME reaction has not got the path parameter. In the data parameter of the FRAME_SENT event the video image
frame which is to be saved using the SaveToFile method is stored.

The reaction allows exporting of video image frame even if the camera is not displaying in the Monitor window.
Method argument:

1. path - mandatory argument. Specifies the full path to save the file with frame.

2. data - mandatory argument. Specifies data to save in file.

3. param - mandatory argument. Defines necessity of conversion from base 64 format before saving. Possible parameter values:
a. true - decode from base64 before saving;
b. false — save string without conversion.

Time of frame saving depends on the anchor frames frequency. The higher the anchor frames frequency, the less time.
Example. Save the frame receiving from Camera 1 in the test.jpg file on the D disk:
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if (Event.SourceType == "CAM" && Event.Sourceld == "1" && Event.Action == "FRAME_SENT")

{
SaveToFile("D:\\test.jpg",Event.GetParam("data"),true);

be

The GetLinkedObjects method

The GetLinkedObjects method is used to get list of objects linked to the specified camera using the Objects connection object ( see the Administrator's Guide, Connection of objects with
cameras section)

Method call syntax:

function GetLinkedObjects(typel : string, id : string, type2 : string)

Method argument:

1. typel - the type of object for which linked objects are to be returned.
2. id - identification number of object for which linked objects are to be returned.
3. type2 - the type of linked objects which are to be returned. If empty string is sent then linked objects of all types will be returned.

Example.

The Objects connection object is configured the following way:

Display in debug window the list of objects linked with the camera 1.

if (Event.SourceType == "MACRO")
{

varmsgstr = GetLinkedObjects("CAM","1","MACRQ")
DebuglLogString("Linked objects " + msgstr);

b
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As a result the "Linked objects MACRO:1" message will be displayed in the script debug window.
The WriteIni method
The WriteIni method is used for writing the string variable to ini-file.

Method call syntax:

function Writelni(varName: String, varValue: String, path: String)

Method argument:

1. varName - required argument. Sets name of variable for saving in the file.

2. varValue - required argument. Sets value of t variable.

3. path - required argument. Sets full path to the ini-file in which variable is to be stored. Storage of variables can be replaced on the network resource. Enter the network path
in the argument for it.

Example. Write the MyVar variable to the \\fs\temp\test.ini file and specify the «Helloworld!” value to it. Then read the written value and display it on the script debug window.

WriteIni("MyVar", "Hello world", "\\\\fs\\temp\\test.ini");
var result = ReadIni("MyVar","\\\\fs\\temp\\test.ini");

DebuglLogString(result);

The ReadIni method

The ReadInimethod is used to read values of string variablein the ini-file.

Method call syntax:

function ReadIni (varName: String, path: String): String

Method call syntax:

1. varName - required argument. Sets name of the variable storing in the file.
2. path - required argument. Sets the full path to the ini-file in which variable is storing.

See example in The WriteIni method section.
The AddIni method
The AddIni method is used to write, change and read integer variable from the ini-file. The method returns the value of variable after its changing.

Method call syntax:



function AddIni(varName: String, varValue: int, path: String): int

1. varName - required argument. Sets the name of variable in the file.
2. varValue - required argument. Sets the value of variable or value which should be added to the existing value of variable:
a. The varValue value will be assigned to the variable if there is a file with the varName name and string value in the file.
b. If there is no variable with the varName name in the file then such variable will be created and the varValue value will be assigned to it.
c. If there is a variable with the varName name in the file and it has integer value or its value is indicated to the integer type, then value will be indicated and the varValue

value will be added to it.
3. path - required argument. Sets the full path to the ini-file in which variable it to be stored. Storage of variables can be placed on the network resource. Enter the network path

in the for it.
Example. There is no the "MyVar" variable in the "C:\\test.ini". Write such variable with the -1 value to the file, then add 1 to it and display the result value on the script debug window.

var result = AddIni("MyVar", -1, "C:\\test.ini");
result = AddIni("MyVar", 1, "C:\\test.ini");

DebuglLogString(result);

The SetTimer method

The SetTimer method is used to start the timer.
The syntax for accessing the method is:

function SetTimer (id : int, milliseconds : int)

Method arguments:

1. id is a required argument. It specifies the timer ID. Allowed values are int or string type.
2. milliseconds is a required argument. It specifies the period with which the timer will trigger if it is not stopped by the KillTimer method. It is specified in milliseconds. Allowed

values are int type.

Example. 2 seconds after the macro 1 is executed, start recording on camera 1.
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if(Event.SourceType=="LOCAL_TIMER" && Event.Action=="TRIGGERED" && Event.Sourceld==333) //it is possible to use Event.Sourceld == "333", i.e.
string ID
{

var actuallyKilled = KillTimer(333);

if(actuallyKilled == 1)

{
DoReactStr("CAM","1","REC","");

b
b
if(Event.SourceType=="MACRO"&& Event.Sourceld == "1" && Event.Action == "RUN")
{

SetTimer(333,2000); //333 - id, 2000 msec = 2 sec - period
b

The KillTimer method

The KillTimer method is used to stop the timer. Returns 1 if timer was stopped as a result of function executed.
The syntax for accessing the method is:

function KillTimer (id : int) : int

Method arguments:
1. id is a required argument. It specifies the timer ID. Allowed values are int or string type.

Example. See in the The SetTimer method section.

The MsgObject and Event objects and their built-in methods and properties
The MsgObject and Event objects

MsgObject is a prototype (template) used to create objects with methods and properties for handling events. The methods and properties of MsgObject allow receiving the
information about objects that send or receive events, generating actions, changing object states, etc.

The methods and properties of the MsgObject prototype can be called via its instance objects or the Event static object.

Event is a static object used to call events in Intellect. The Event object represents the system event that launched the script. All MsgObject methods and properties are available for
the Event object.

The CreateMsg method of the Core object is used to create instances based on the MsgObject prototype.

The GetSourceType method
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The GetSourceType method returns the type of the MsgObject or Event object.
Method call syntax

function GetSourceType() : String

Method arguments: no arguments.

Usage examples

Problem. When Macro 1 starts, arm Detection Zones *.1 in the Day mode for Cameras N2 1 — 4. When Macro 2 starts, arm Detection Zones *.2 in the Night mode for Cameras N¢ 1 -
4. When Macro 3 starts, arm Detection Zones *.3 in the Rain mode for Cameras N2 1 - 4.

(D Note

Symbol "*" corresponds to identification number of a camera in the system (from 1 to 4)
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if(Event.GetSourceType() == "MACRO" && Event.GetAction() == "RUN")
{
var k;
//Switching the cameras to the Day mode by arming the *.1 detection zones
if(Event.GetSourceld() == "1")
{
for (k =1; k<=4; k =k+1)
{
DoReactStr("CAM_ZONE", k + ".1", "ARM", "");
DoReactStr("CAM_ZONE", k + ".2", "DISARM", "");
DoReactStr("CAM_ZONE", k + ".3", "DISARM", "");
b
b

//Switching the cameras to the Nigh mode by arming the *.2 detection zones
if(Event.GetSourceld() == "2")

{
for (k =1; k<=4; k= k+1)
{
DoReactStr("CAM_ZONE", k + ".1", "DISARM", "");
DoReactStr("CAM_ZONE", k + ".2", "ARM", "");
DoReactStr("CAM_ZONE", k + ".3", "DISARM", "");
b
b

//Switching the cameras to the Rain mode by arming the *.3 detection zones
if(Event.GetSourceld() == "3")
{
for (k = 1; k<=4; k=k+1)
{
DoReactStr("CAM_ZONE", k + ".1", "DISARM", "");
DOReaCtStI’("CAM_ZONE", k + ||-2||, "DISARM", Illl);
DoReactStr("CAM_ZONE", k + ".3", "ARM", "");
b
b
b

The GetSourceld method



37

The GetSourceld method returns the identification number of the MsgObject or Event object.

Method call syntax

function GetSourceld() : String

Method arguments: no arguments.

Usage examples

See the example for the GetSourceType method.

The GetAction method

The GetAction method returns the event received as an Event object or specified for a MsgObject object.

Method call syntax

function GetAction() : String

Method arguments: no arguments

Usage examples

See the example for the GetSourceType method.

The GetParam method

The GetParam method returns the value of the specified parameter of the MsgObject or Event object.

Method call syntax

function GetParam(param: String) : String

Method arguments:

param - required argument. The name of the parameter of the object created using MsgObject (or of the Event object). It takes the following values: type - String, range -
available parameters for the objects of the specified type.

(D Note

If the object has no parameter with this name, then the method restores an empty string

Example. When any event from any camera is registered, check from which computer the event comes. If the computer has "WS3” name, create the event copy where the computer’s
name is “"Computer”.
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if (Event.SourceType == "CAM")
{

var msg = Event.Clone();

if (msg.GetParam("slave_id") == "WS3")
{

msg.SetParam("slave_id", "Computer");
NotifyEvent(msg);

b
b

The SetParam method
The SetParam method assigns a value to the specified parameter of the MsgObject or Event object. It changes only the specified parameters, leaving other parameters intact.

Method call syntax

function SetParam(param : String, value : String)

Method arguments:

1. param - Required argument. The name of the parameter of the object created using MsgObject (or of the Event object). It takes the following values: Type - String, range -
available parameters for the objects of the specified type.
2. value - Required argument. The value to be assigned to the parameter specified in the param argument. It takes the following values: Type - String, range - depends on the

parameter.
Usage examples
See the example for the GetParam method.
The MsgToString method
The MsgToString method transforms MsgObject objects (including the static Event object) into a String variable.

Method call syntax
function MsgToString() : String
Method arguments: no arguments.

Usage examples

Problem. Send the messages about all events registered for Microphone 1, to a specified e-mail address.
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.[:D Note

The Short Messages Service is supposed to be installed and working properly.

if (Event.SourceType == "OLXA_LINE" && Event.Sourceld == "1")

{

var msgstr = Event.MsgToString();
DoReactStr("MAIL_MESSAGE", "1", "SEND", "subject<Microphone 1>,body<" + msgstr + ">");
DoReactStr("MAIL_MESSAGE", "1", "SEND", "");

b

The StringToMsg method

The StringToMsg method transforms a String variable into an MsgObject object.
Method call syntax

StringToMsg(msg : String) : MsgObject

Method arguments:

msg - Required argument. A String type variable to be transformed into an MsgObject object. It takes the following values: Type - String; range — character string that matches the
syntax for MsgObject representation:

"objtypelid|action|paraml<valuel>,param2<value2>..", where
objtype - object type;

id - object identification number;

action - event or action for the object;

paraml<valuel>,param2<value2> - list of parameters and their values. Elements of the list are separated by commas with no white space. If no parameters need to be specified,
an empty string is used after the vertical line (|), for example:

"CAM|1|MD_START|"
Usage examples

Problem. Upon an alarm in Sensor 1 or 3, start recording audio from Microphone 1. Upon an alarm in Sensor 2 or 4, start recording audio from Microphone 2.
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if (Event.SourceType == "GRAY" && Event.Action == "ALARM")

{
var audioid;
if (Event.Sourceld == "1" || Event.Sourceld == "3")
{
audioid = "1";
b
if (Event.Sourceld == "2" || Event.Sourceld == "4")
{
audioid = "2";
b

var str = "OLXA_LINE|"+audioid+"|ARM|";
var msg = CreateMsg();
msg.StringToMsg(str);

NotifyEvent(msg);

The StringToParams method

The StringToParams method transforms a String variable into the list of parameters and overwrites the existing parameter list of the MsgObject object.

Method call syntax

StringToParams(String params)

Method arguments:

params - Required argument. A String type variable to be transformed into a list of parameters for the MsgObject object. It takes the following values: String variables matching the
syntax for MsgObject parameter list representation:

“paraml<valuel>,param2<value2>...”, where

paraml<valuel>,param2<value2> - list of parameters and their values. Elements of the list are separated by commas with no white space. If no parameters need to be specified,
an empty string is used after the vertical line (|), for example:

“CAM|1|MD_START|"”
Usage examples

Example. Upon registration the connection (“Attach”) event for any camera, in the system retrigger the “Attach” event with modified Number of the PTZ device (telemetry_id) and N
umber of the microphone for synchronous recoeding (audio_id) parameters. The values should be equal to the corresponding camera numbers plus 1.
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if (Event.SourceType == "CAM" && Event.Action == "ATTACH")
{

var i;

for (i=1,i<=4;i=i+1)

{

var msg = Event.Clone();

var str = "telemetry_id<" + (i+1) +">,audio_id<" + (i+1) + ">";
msg.StringToParams(str);

NotifyEvent(msg);

3
b

The Clone method

The Clone method creates a copy of an MsgObject or Event object.

Method call syntax
Clone() : MsgObject
Method arguments: no arguments.

Usage examples

Problem. When Relay N91 closes, start video recording from Camera 1 and close Relay N22. When Relay N21 opens, start video recording from Camera 2 and open Relay N92.
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if (Event.SourceType == "GRELE" && Event.Sourceld == "1")
{
var msgevent = Event.Clone();
if(Event.Action == "ON")
{
msgevent.Sourceld = "2";
DoReact(msgevent);
DoReactStr("CAM","1","REC","");
DoReactStr("GRELE","2","ON","");

b
if(Event.Action == "OFF")
{
msgevent.Sourceld = "2";
DoReact(msgevent);

DoReactStr("CAM","2","REC","");
DoReactStr("GRELE","2","OFF","");

b
b

The GetObjectlds method

GetObjectlds method is responsible for receiving identifiers from all the objects of a specified type.

Method call syntax:

function GetObjectIds(objectType : String)

A line is replied :
CAM||COUNT]|id.3<5>,id.count<4>,id.0<2>,id.1<3>,id.2<4>
where id.count<> - number of ID objects,

id.[count]<> - ID object.
Method’s arguments:

objectType -required argument. Set the type of the system object, for which the value of the given parameter should be given back ("CAM","GRAY","GRABBER" e.t.c.).Accepted
values: type String, range is restricted by object types registered in the system.
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Example. All the cameras should be armed upon the start of MacrosN?1.

if (Event.SourceType == "MACRO" && Event.Sourceld && Event.Action == "RUN")
{

var msg = CreateMsg();
msg.StringToMsg(GetObjectlds("CAM"));

var objCount = msg.GetParam("id.count");

var i;

for(i = 0; i < objCount; i++)

{

DoReactStr("CAM", msg.GetParam("id." + i), "ARM", "");
b

¥

The GetObjectParams method

GetObjectParams method is designed for getting the object’s parameters.

Method call syntax:

function GetObjectParams(objectType : String, objectld : String)

Method arguments:

1. objectType - required argument. Set the type of the system object ("CAM", "GRAY", "GRABBER" e.t.c.), for which the type of a parent object should be given back. Accepted
values: type String, range is restricted by object types registered in the system.
2. objectId - object’s identifier. Accepted values: String type.

Example. It is necessary to check the color control of camera N22 upon the start of MacrosN?1. If camera 2 is a color one, set it to recording.

if (Event.SourceType == "MACRO" && Event.Sourceld && Event.Action == "RUN")
{

var msg = CreateMsg();
msg.StringToMsg(GetObjectParams("CAM", "2"));

if(msg.GetParam("color") == "1")
{
DoReactStr("CAM", "2", "REC", "");
b
b



The SourceType property
The SourceType property stores the system type of the MsgObject or Event object.

Property call syntax

SourceType : String

Usage examples

Problem. When Relay 1 closes (for example, the button connected to the relay is pressed), print the frames from Cameras 1 and 2.

if (Event.SourceType == "GRELE" && Event.Sourceld == "1" && Event.Action == "ON")
{

//activating the Camera 1 window
DoReactStr("MONITOR","1","ACTIVATE_CAM", "cam<1>");
//printing the frame from Camera 1
DoReactStr("MONITOR","1","KEY_PRESSED","key<PRINT>");
//activating the Camera 2 window
DoReactStr("MONITOR","1","ACTIVATE_CAM", "cam<2>");
//printing the frame from Camera 2
DoReactStr("MONITOR","1","KEY_PRESSED","key<PRINT>");

The Sourceld property
The SourceType property stores the identification number of the MsgObject or Event object.

Property call syntax

Sourceld : String

Usage examples

See the example for the SourceType property.

The Action property
The Action property stores the action or event of the MsgObject or Event object.

Property call syntax

44
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Sourceld : String

Usage examples

See the example for the SourceType property.

Programming tools
The Script object

The Script object is designed for initializing and setting the parameters of JScript scripts in Intellect system.

Figure shows the settings panel for the Script object.
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1 Attention!
Creating of large number of the Script objects (more than 100) can result to instable system working.

The settings panel allows choosing the time zone and the computers (kernels) for executing the script.

@ Note.

To set all checkboxes checked select one in the column and click Ctrl+A. To set all checkboxes unchecked select one and click Shift+A.

It also has the button for starting the Editor-Debugger tool and the text window for viewing the script text created by means of this tool. The scripts can be edited in the Editor-Debugg
er tool or directly in the settings panel for the Script object.

Moreover, one can configure the filter of events - the list of events which are to be processed by the Script system object. In general, including the event to the filter equals to if opera
tor in the text of script, i.e. when the event is in the table, the operator can be omitted.

1 Attention!

The event filter is to be set when creating a script in large distributed configurations. Otherwise the module will process all incoming events and it will lead to module
malfunctioning.

Example
(D If the Object’s type column has the Macro value, the Identifier column has the 1 value and the Event column has the Executed value, then

if (Event.SourceType == "MACRO" && Event.Sourceld==1 && Event.Action == "RUN")
{

b

DoReactStr("CAM", "2", "REC", "");

script can be used instead of script.

DoReactStr("CAM", "2", "REC", "");

The detailed information on the elements of the settings panel for the Script object is given in Administrator’s guide.

Example.
(D Recording on Camera 1 is to be started when controlling PTZ device in the Video surveillance monitor.

For this adjust the Script object as follows:

1. Select the required time zone when the script is to be executed.
2. Enter the script text:


https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=136250443

- Fiun on specified computers
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DoReactStr E"CMI"'- "J-"f "REC"' ""J :
H
[« | Bl
Editor - Debugger |
Ohject's type | Ide... | Object's name Ewent
CORE DO_REACT

Cancel

3. Adjust the filter as follows:
a. Select CORE in the Object’s type dropdown list.
b. Enter DO_REACT in the Event field.
The filter can be set by the UPDATE_OBJECT event of the CORE object. Example command to add Camera 1 object to the Script 2 filter:

NotifyEventStr("CORE","","UPDATE_OBJECT","objtype<SCRIPT>,0bjid<2>,EVENT.objid.0<1>,EVENT.objid.1<10>,EVENT.action.count<2>,flags<>,EVENT.action.0<>,EVENT.action. 1
<>,EVENT.objtype.0<CAM> EVENT.objtype.count<2>,EVENT.objtype.1<CAM>,EVENT.objid.count<2>");

The Editor-Debugger utility

The Editor-Debugger utility is designed for creating, debugging and editing scripts in the Intellect software package.

Figure shows the Editor-Debugger dialog window.
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The Editor-Debugger utility contains the built-in text editor and the debugger window.

To help with writing correct codes, the text editor automatically highlights objects, methods and properties in different colors.

The debugger window allows viewing the information about all events registered by the system. You may filter the events to be shown in the debugger window. A separate debugger
window is created for each Script object, which allows each script to be debugged individually using the filters.

To debug a script, the utility can generate test events which will not be registered by the system.

Scripts can be saved as Script objects or as text files on the hard drive.

The Debug window

Intellect allows viewing all events and reactions happening in the system in real time mode. Events and reactions with object properties are displayed in the Debug window. They can
be copied to the Windows clipboard and then used in programs.

Enabling the Debug window

By default the debug window is disabled. To enable the debug window, do the following:

1. Shut down Intellect.



2. Run the Tweaki.exe utility.

Note.
The Debug window can be enabled without the tweaki.exe utility. For this set values 1, 2 or 3 for the Debug string parameter in the
HKEY_LOCAL_MACHINE\SOFTWARE\ITV\Intellect section of the Windows registry (HKEY_LOCAL_MACHINE \Software\Wow6432Node\ITV\Intellect for 64-bit system).

Select Intellect section in the tree on the left side of the utility dialog box.
Change the value of the Debug mode parameter from Disabled to Debug 1, Debug 2 or Debug 3.
Click the OK button.

Start Intellect.
A new Debug window item appears on the Main control panel of Intellect.
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(D Note.

This menu is also available in the Windows notification area (system tray) - left click on the il button or short click the F8 hot key.
@ About program..

1 5 Debug window i

| 4] System settings

5] Logoff

8. Select the Debug window item on the Main control panel in order to display the Debug window on the monitor. The selected Debug window item is marked with a flag.
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t E Ciebug window )

5] Syshem settings

5] Logoff




To hide the Debug window, re-select the Debug window item on the Main control panel.

(D Notg.

To disable the Debug window, select the Disable value for the Debug mode in the tweaki.exe utility or set value 0 for the Debug string parameter in the
HKEY_LOCAL_MACHINE\SOFTWARE\ITV\Intellect section of the Windows registry (HKEY_LOCAL_MACHINE \Software\Wow6432Node\ITV\Intellect for 64-bit system). These
actions are performed when Intellect is exited.

Working with Debug window

Look at the figure of the Debug window. The Debug window displays the sequence of events and reactions in the system.

Clear | Calors | Filber | [ apply filter Seatch |

-]
React : OPERATORPROTOCOL|1|DEACTIVATE| _ slave_id=S-UYIUTOWA, 1 =, panel_active <=, user_id<>
Event : CORE||[DISPLAY _CHANGE_ACTIVE|date<07-10-14 =, fraction <609 ,gui<1 =, guid_pk<{7EZ3C00A-DD4D-E41 1-B666-001 636069930 =, ovner <5-LYLTOWA =, ne <08:5:
Ewent : DISPLAY|1|ACTIVATE|date <07-10-14 = Fraction<325 =, guid_pk<{5223C00A-DD40-E41 1-B666-001636069930 =, awner <5-UYUTOWA > panel_active <0, slave_id<S-L*
React : MOMITOR|1|ACTIVATE|_ slave_id<S-UYUTOVA =, panel_active<0=, user_id<>
React : SLAYE|S-UYUTOVA|DISPLAY CHAMGE ACTIVE|display id<1>
Event : CORE||DISPLAY _CHANGE_ACTIVE|date <07-10-14 =, fraction <343, gui<1 =, guid_pk<{8323C00A-DD4D-E41 1-B666-001 636069930 =, ovner <5-UYUITOWA =, kine <08:5:
Event : CAM|3|DETACH|care_global <1 =, date <07-10-14 =, fraction <125, quid_pk <{008ASBEE-DD4D-E41 1-B6AA-001636069930} =, owner <5-LYUTOVA =, slave_id<5-LUVUTOWA
React : MONITOR |1 [REMOVE_ALL|_ slave_id=S-L¥UTOVA >
React : MOMITOR|1]ADD]__slave _id<S-U¥UTOVA=,arch_id<>, audio_id<,audio_type<> cam<1:=,cam_zone_count <03, ompression <=, compressor < =,control<1 =, decompre
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Here are the features of the Debug window:
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always on top;

QOUTAWN

1. Highlight the required line in the Debug window.

the size of the Debug window is changed using the mouse;

information on event or reaction can be copied to the Windows clipboard and then used in programs;
events and reactions can be filtered in the Debug window;

events and reactions can be highlighted in the Debug window;

it is possible to search for events or reactions in the Debug window.

To read and/or copy data on event or reaction to the Windows clipboard, do the following:

Regular expressions can be used in order to highlight and filter messages in the Debug window.
Copying information on event or reaction to the clipboard

2. Right-click on the highlighted line. The Info window with info on required event or reaction appears.
3. Highlight the information that is to be copied to the Windows clipboard and click Ctrl+C.

Note.

Use the context menu for operations with text in the Info window (right-click on the highlighted text).

4. To close the Info window, click the EI button.

Debug window
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React : MOMITOR|1|REMOWE_ALL|_ slave_id<5-UvU
React : MOMITOR|1]ADD|__slave_id<3-UYUTOVA:, 2
React : MOMITOR|1|ADD|__slave_id<3-UYUTOVA >, 2
React : MOMITOR|1|SETUP|43<03,CAM. arch,0< >, C
Event ; MOMITOR|1|ACTIVATE_CAM|cam<1:=,core_c
Event : MOMITOR|1|ACTIVATE _CAM|cam<1 = core_c
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»

Information on event or reaction is now copied to the Windows clipboard.

Highlighting messages

To configure message highlighting in the Debug window, do the following:

1. Click the Colors button.
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CODA-DD4D-E41 1-Bees-001 636063930

MOMITOR|1|A0D] _ slave id=S5-UVUTOWA =, arch_id< =, audio_id=>,audio_twpe < =,cam=<1>,cam_zone_count <0, compression <=, Compressor <

MOMITOR |1 |SETUP|43 =0, CAM, arch, 0=, CaM,arch. 1 <, CAM, arch, 2 <=, CAM. arch, count <3 =, CAM, cam. 0 <1 =, CAM. cam, 1 <2 =,CAM.cam. 22
MOMITOR| 1| ACTIVATE_CAM|cam <1 =,core_alobal <1 >,date<07-10-14 =, fraction <825 =, guid_pk<{30530763-DE4D-E41 1-Bo6A-001636069930
MOMITOR |1 |ACTIVATE CAM|cam <1 =,core_global<1 > date<07-10-14 =, fraction <937 =,quid_pk={31540753-DE4D-E41 1-Bo6A-001636069930

| 5

-

. In the Highlight in window specify the line that is to be highlighted every time it appears in the message (1).

BB
ﬁasic colors: 1 \
= s ;
(rString \
\Event _j
1
LCustom colors:;
EEEEEEEN Hue|4_ Red: [255
EEEEEEN - oy
| I _’I Sat: 240 Green: |255
2 5 Define Eustom Eolors s> ColarlSaid - [132 Blue [153 /
t QK b Cancel | r 4 Cancel | Addta Mistan Colors |

Click the Color button (2).

Select the color in the Color common dialog box (3).
Click the OK button(4).

Repeat steps 2-5 for all required lines.

Note.
To add a line to the table, click the key on the keyboard.

. Click the Yes button (5).




53

As a result messages with the specified line are highlighted in the Debug window.
QDebugwindow B
Clear | Colars I Filter | [~ Apply Filker Search |

React ; OPERATORPROTOCOL|L|DEACTIVATE|  slave id<3-UYUTONA, 1= panel_ackive <=, user_jd<>=
Event : DISPLAY|1|ACTIVATE|date <07-10-14 >, Fraction <3255, quid_pk<{8223C0DA-DD4D-E41 1-BEEA-001636063930} =, owner <5-LYUTOVA, panel_a
! React ; MONITOR| 1 |ACTIVATE|_ slave_id <5-UWUTONA =, panel_active <0z, user_id<>

React : SLAYE|S-UYUTOVA|DISPLAY_CHANGE_ACTIVE|display_id<1>
verit : CORE||DISPLAY_CHANGE_ACTIVE|dabe <07-10-14 > Fractio

React : MOMITOR|1[REMOYE_ALL|_ slave_id<S-UYUTOMA =

React : MOMITOR|1|ADD|__slave_id=<5-UYUTOWAZ, arch_id <=, audio_id < =, audio_type <>, cam<1 »,cam_zone_count <0, compression <=, compressor =
React : MOMITOR|1|ADD|__slave_id<S-UYUTOWAS, arch_id <>, audio_id < >, audio_type <, cam <2 =, cam_zone_count <0, compression <=, compressor <
Feact ; MOMITOR|1|SETUP|43=0%,CAM, arch, 0=, CAM,arch. 1 <%, CAM, arch, 2 <=, CAM, arch, count <3 =, CAM, cam. 0 <1 =, CAM, cam, 1 <2 =, CAM.cam, 22

1| | 5

The messages are now highlighted.
Event and reaction filter

The filter of events and reactions allows displaying only required messages in the Debug window.

To configure the filter of events and reactions, do the following:

1. Click the Filter button.
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£

Clear || Calars ( Filker )I_ &pply Filker Search |

Event

Ewvent

1

Reack :
Ewvent :
: DISPLAY| 1| ACTIVATE |dake <07-10-14 = Fraction <328 =, quid_pk<{8223C0DA-D040-E41 1-B666-001 636069930 =, owner <5-UYLITOMA =, panel_a

Reack
Reack :

{ CORE||DISPLAY CHAMNGE ACTIVE|dat 7-10-14= fractio

Reack
Reack
React :
React :
Ewvent :
Event :

QOPERATORPROTOCOL|1|DEACTIVATE|_ slave_id<S-UYUTOWA. 1 =, panel_active< =, user_id=x»
CORE||DISPLAY _CHAMGE_ACTIVE|date <07-10-14 = fraction<609=,gui<1 =,quid_pk<{7E23C00A-D04D-E4 1-B666A-001 636069930} =, owner <35

MOMITOR|1JACTIVATE|  slave id<S-UYUTOMA =, panel_active <0z, user_jd< >
SLAVE [S-ILVUTOWA|DISPLAY _CHAMGE _ACTIVE [display _id<1=

: CAM|3|DETACH|core_global <1 =, date<07-10-14 = Fractlonc:125>,gu|djk{{DDSA68EE -DD4D- E411 BISE.E. 001636D6993D}> ner <5- U"r'UTO'I.-'.C\.

MOMITOR|1|REMOVE_ALL|_ slave_id<S-UYUTOWA =

MOMITOR|1]A00D] _ slave id«<S-UYUTOMA =, arch_id <>, audio_id <>, audio_tvpe==,cam<1=>,cam_zone_count<03,compression< =, COmpressor <
MONITOR|1[ADD]__slave_id<5-UvUTOYA =, arch_id< >, audio_id<>,audio_type< = cam<2>,cam_zone_count<0>,compression < =, COMpressor <
MOMITOR|1|SETUR| 43 <0, CAM, arch, 0=, CAM. arch. 1 < =, CAM. arch. 2 <>, CAM, arch, count =3 =, CAM. cam, 0= 1 =, CAM, cam. 1 <2 >, CAM.cam. 2 <2
MOMITOR|1[ACTIVATE_CAM|came1 = core_global<1 = date <07-10-14 =, fraction <526 =,guid_pk<{805AD763-DE4D-E41 1-B666-001 636069930}
MOMITOR | 1| ACTIVATE_CAM|cam <1 =, core_global<1 =,date <07-10-14=,fraction <937 =,quid_pk<{515A0763-DE4D-E411-B666-001 636069930

-

| 3

2. In the Filter window specify the lines that are to be in the message for it to be displayed in the Debug window (1).

e x|

Enable

- |
| |Event )

| ~Exclude

| f React i

o ) o |

3. Specify the lines that are to be in the message for it to not be displayed in the Debug window (2).
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Note.
To add a line to the table, click the key on the keyboard.

4. Click the Yes button (3).
5. To apply the filter, set the Apply filter checkbox checked.

Clear | Colars | Filker mv' Apply Filer ’ Search |

Ewvent

Ewvent

Event

Ewent :
Event :
Event : -
1 SLAYE|S-UVUTOVA|SET_DECOMPRESSORS|_TRAMSPORT _ID<1111>,codec0<BOSCH >, codecl <FFmpegallnOnelecoder =, codec 10 <MPEGHIppL

Event
1 SLANE |S-UVLITOWA |DISC_EXIST|core_global<1 =,core_slave_global=1 =,date<07-10-14 = fraction <562 =,guid_pk={57366171-DE40-E41 1-BAAA-
Event :
Event :
Event
Event
Ewvent :
i TIME_ZONE| 1 | DEACTIVATE |date <07-10-14 =, fraction <640 =, quid_pk<{C5543473-DB40-E41 1-B666-001 636063330} =, owner <5-LYUTOMA =, ki
Event :

FTent ;

SLAYE | 5-LIYUTONA | COMNECTED |SOCKET <192, 168.0,2 >, TRAMSPORT _ID<1111 =, TRANSPORT _TYPE<SOCKET =, TRAMSPORT ID<> care_glob
SLAYE|S-UYUTONA|IMNITED | _TRAMSPORT _ID<1111=,care_global<1 =, care_slave_global <1 =,date<07-10-14 =, fraction <640 =, guid_pk<{35EE94
SLAVE|5-UYUTOMA|SET _COMPRESSORS] _TRAMNSPORT ID<1111>,codec0<MIPEG>,codecl <Mation Wavelet 3.5, codec? <Mation Wavelet 7,13

_SLAVE|S-UYUTOVA|COMMECTED | SOCKET <192, 168.0.22, TRANSPORT_ID <1050, TRANSPORT _TYPE<SOCKET >, TRANSPORT ID<>,core_glo

CORE|| DD _REACT|ackion<GET_TITLE_PARAMS = care_dlobal<1 =,date <07-10-14 =, Fraction <796 =, guid_pk<{58566171-DE40-E41 1 -Baoa-00167
SLAVE | 5-UYUTOMA|EXECUTE COMPLETE| _TRAMSPORT _ID=1111=, command<video.run core|video.run core|audio.run]audio, run=,core_global <
DISPLAY|1|ACTIVATE|date <07-10-14 > Fraction <609 =, guid_pk<4{C2543479-DB40-E41 1-BE66-001 636069930} = owner <5-UYUTOVA S slave_id-
SLAYE |S-LVUTOWA|REGISTER_USER |date<07-10-14 = fraction<515>,quid_plk={C1543473-DE40-E41 1 -E666-001 636069930} =, omwner <5-LY LT
CORE||DISPLAY CHANGE_ACTIVE|date <07-10-14 = fraction=<609=,gui<1 =,guid_pk=<{C3543479-DE40-E41 1-B666-001 636069930} =, owner <5

SLAVE | 5-IUYUTOMA|EXECUTE COMPLETE| _TRAMSPORT ID=1111=, command<video.run core|operatorprotocol kun 1= core_global <1 = date=0%

SLAVE]S-LYUTONAI CONMECTED | SOCKET 192, 168,0, 2> TRANSPORT ID<IDDT>.TRF\NSF‘ORT TYPE<SOCKET =, TRANSPORT ID<>.EDrEﬁLI
3

As a result only messages that fit the search criteria are displayed in the Debug window.

The event and reaction filter is now configured.
Searching for events and reactions

To search for events and reactions, do the following:

1. Click the Search button (1). The Search window appears.




Debug window |
Clear | Colors | Filter | I~ Apply filker ‘I 1

React : SLAVE|LADA|SETUP|CONNECTIONS, connection. count <0, CONMECTIONS, events, count <0, COMNECTIONS. quid . count <0, COMMECTIONS.ip_address, cour
React : SLAYE|LADA|GET_COMPRESSORS|

React : SLAYE|LADA|GET_DECOMPRESSORS|

React ; SLAVE|LADA|EXECUTE_SET|command < =, module_type <server =, slave_tvpe<lz>

Event : SLAYE|LADA|CONMECTED |SOCKET <192, 166,04, TRAMSPORT_ID<1111=, TRANSPORT_TYPE<SOCKET =, TRANSPORT_ID <>, core_global<1 = date<07-10
Event : SLAVE|LADA|INITED|_TRAMSPORT_ID<1111=,core_global<1=,core_slave_alobal<1 >, date<07-10-14 = fraction<156,guid_pk«{518015E_-F14D-E411-B71
Event : SLAVE|LADA|SET _COMPRESSORS| TRAMSPORT ID«1111 >, codecl<MIPEG =, codecl <Mation \Wavelet 3,5 codecZ <Motion \Wavelet 7.1 = codec3<Motion W
Event : SLAVE|LADA|SET _DECOMPRESSCRS| TRAMSPORT ID<11113>,codec0<BOSCH=,cod i ﬁ _I_I

Ewvent : SLF\\I’ElLF\DF\lEXECUTE COMF‘LETEl TRF\NSF‘OR D<1111 5, command < l:l:ure_glc:bc
: . % Find what; ‘ b Fird Ne:-:t

3 ¢ Match whole ward u:unID —
4] 4 {! Match caze) 5 7

Specify the search criteria in the Search for: field (2).

If the specified string is to be searched as a whole word, not a part of any other word, then set the Match whole word checkbox checked (3).
If the search is to be case sensitive, then set the Case sensitive checkbox checked (4).

Set the Direction switch into the position corresponding to the search direction (5).

. To view the following search result, click the Find next button (6).

@ Note.

To close the Search window click the Cancel button.

Direction
" Up ™ Down

ouAwN

The search for events and reactions is now complete.
Clearing the Debug window

To delete all messages from the Debug window, click the Clear button.



Debug window |
Colors | Filker | ¥ &pply Filker

Event : SLAVE|S-LYUTOWA|CONMECTED | S0CKET <192, 1658.0.2 =, TRANSPORT _ID<1111>, TRANSPORT _TYPE=SOCKET >, _TRANSPORT_ID <> core_alob
Ewvent : SLAVE|S-UYUTOWA|IMNITED|_TRAMNSPORT_ID=1111=,core_global<1=,core_slave_global <1 =, date<07-10-14 =, fraction <640 =,0uid_pk<{356E94
Event : SLAVE|S-UYUTOVA|SET_COMPRESSORS|_TRAMSPORT ID<1111>,codecd<MIPEG >, codecl <Mation Wavelet 3.5, codece <Motion \Wavelek 7.1: |
Event : SLAVE|S-UYUTOWA|SET_DECOMPRESSORS| _TRAMSPORT _ID<1111>,codec<B0SCH >, codecl <FFmpegallinOnebecodet =, codecl 0<MPEG4Ippl
Ewent : _SLAYE|S-UYLITOWA|CONNECTED|SOCKET <192, 168.0,2 =, TRANSPORT ID<1050%, TRANSPORT TYPE<SOCKET=, TRAMSPORT ID<=,core_glo
Ewvent : SLAVE|S-UYUTOWA|DISC_ERXIST|core_global<1 =, core_slave_global <1 =, date<07-10-14= Ffraction <562 =, quid_pk={57366171-DB40-E411-Baa6-
Event : CORE||DO_REACT|action<GET_TITLE_PARAMS> core_global<1> date<07-10-14 = fraction <796 >,quid_pk<{58566171-DE40-E411-B666-0016
Event : SLAVE|S-UYUTOWA|EXECUTE _COMPLETE| _TRAMSPORT_ID=1111>,command<videa run core|video,run core|audio.run|audio.run =, core_global <
Ewent : DISPLAY|1|ACTIVATE [date <07-10-14= fraction <609 >, quid_pk<{C2543479-DE40-E41 1-BE66-001636069930 =, owner <S-UYUTOYA S slave_id:
Event : SLAVE|S-UYUTOMA|REGISTER _UISER, |date <07-10-14=,Fraction <515 =, quid_pk<{C1543470-DB40-E41 1-BA6E-001636069930} =, owner <S5-LY LTt
Event : CORE||DISPLAY CHANGE ACTIVE|date<07-10-14> Fraction<609:,qui=1>, quid_pk={C3543479-DB40-E41 1-B666-001636069930 =, awner <5
Event : TIME_ZOMNE|1|DEACTIVMATE |date <07-10-14 =, fraction<640>, quid_pk={ 5543473-DB40-E41 1-BAEE-001 636069930} >, omner <S-LVUTOWA =, ki
Ewvent : SLAVE|S-UYUTOWA|EXECUTE _COMPLETE| _TRANSPORT_ID=<1111=,command = idea.run core|operatarprotocal, run 1=, care_global <1 =, dake<07%
ﬂent: SLAVE SV UTOVAICOMMNECTEDISOCKET <192, 1680, 2 =, TRANSPORT IDilDD?}.TRANSPORT TYPE=<SOCKET =, TRAMNSPORT ID::.‘#.mreﬁll

Getting the list of object names, reactions and events in INTELLECT™

The list of object names, reactions and events used while programming in INTELLECT™ software can be got with the help of ddi.exe tool.
ddi.exe tool is started in one of the following ways:
1. “Start All Programs Intellect Tools System configuration.
Note
ddi.exe tool is available in the Start menu with the following types of Intellect installation: Server, Administrator’'s workplace and Workplace for monitoring
2. In the Tools folder of Intellect installation folder.
To view the list of object names, events and reactions, do the following:

1. In the tool, open intellect.ddi file.
2. Select the DDI tab on the left (1). The list of system objects is displayed here.



#: DDI & DBI Editor =10l
Fil: q 3

DBl | 2 ‘Namesl Eventsl Heactionsl Labelsl Statesl Transition rulesl
ACTIVER \;
¥ ARCH Mame
-4 ARCHIVER |
. ARCHPANEL
- ATM Group name

-4 ATMA25_CLIENT |
9@ ATHx25_SERVER

3 ATH_ITY Search by name

P CAM i

- Cak_FACECAPTURE I

- CAM_IP_DETECTOR | Object Marne

. Cam_TITLE CiamM Camera

- CAM_VMDA Cak_FACECAPTURE Face capture camera

- Cam_vMDa_DETECT Cak_IP_DETECTOR Embedded detector

. CAM_ZONE CAM_TITLE Titles database

- COMFIG CamM_VMDA, Tracker

.99 DEFARTMENT CaM_VMDA_DETECTOR Detectar
CaM_Z0ME Detection zone

- DIALOG

- DISPLAY

-4 DMD

.49 DRS

- EVENT_COUNTER
-9 EVENT_VIEWER

W GATE
-4 GRAEEER
W GRAY
\ ¥ GRELE JE
> ral
|obiects in total 172 A

3. In the DDI tab, select the object which events and reactions are to be viewed (2).
4. To view the name of the selected object, go to the Names tab (3).
5. To view the list of events for the selected object, go to the Events tab.
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> DDI & DBI Editor - [C:\Program Files\MuTennexT\Languages\en\intellect.ddi]
File
ool ol |

=1ol ]

ACTIVEX
ARCH

ARCHIVER
ARCHPANEL

ATM
ATMX25_CLIENT
ATMX25_SERVER
ATM_ITV

CAM
CAM_FACECAPTURE
CAM_IP_DETECTOR
CAM_TITLE
CAM_VMDA
CAM_VMDA_DETECTOR
CAM_ZONE

CONFIG
DEPARTMENT
DIALOG

DISPLAY

DMD

DRS
EVENT_COUNTER
EVENT_VIEWER

GRABBER

LEVEL

LMCFTP
LMCGATE
MACRO
MAIL_MESSAGE
MAIN

MAF
MAPLAYER
MAPPLATFORM
MESSAGE

MMS

MONITOR

|»

[

CONNECT_FAIL

Connection emor

‘ Support audio

Disable network
connection

Disable logging Windows log

CONNECT_OK

Connected

NETWORK_FAIL...

Connection lost

STATE_CONNEC...

Connection restored

Einlinlininin B B e

Einlinlininin B B BN e

OO o o o o 6 OF OF OF o o1 0F uF o o oY |
Eliniiniininln = & B N RN e e

Total objects: 70

6. To view the list of reactions for the selected object, go to the Reactions tab.




%> DDI & DBI Editor - [C:\Program Files\Murennexrt\Languages\en\intellect.ddi] - ) oy ] 4

File

Dol | DEI I Names E\ferrts(HBﬂdiOﬂS‘Iccns I States I Transition ules I

ACTIVEX Reaction | Description Arming
ARCH

ARCHIVER > [ - oo
i?ﬁHPAN EL MUX2_OFF Disable video output 2
ATMX25_CLIENT MUX3_OFF Disable video output 3
ATMX25_SERVER
ATM_ITV *
CAM
CAM_FACECAPTURE
CAM_IP_DETECTOR
CAM_TITLE

CAM_YMDA
CAM_VMDA_DETECTOR
CAM_ZONE

CONFIG

DEPARTMENT

DIALOG

DISPLAY

DMD

DRS

EVENT_COUNTER
EVENT_VIEWER

GATE

GRABBER

| v

a|a(a(o

GRAY

. a_llq_llglﬁE Parameters of action "Disable video output 1:

KEYB Parameter Name Type | Element | Value

LEVEL

LMCFTF
LMCGATE
MACRO
MAIL_MESSAGE
MAIN

MAP

MAPLAYER
MAFFLATFORM
MESSAGE

MMS

MONITOR 4

*
4

Total objects: 70

The detailed information on working with ddi.exe tool is given in Administrator’s guide.

Note.
If the Sensor is armed, then at the Sensor switching on/off the "Alarm" event appears depending on the alarm mode setting (see the Creating and configuring the Sensor
system object section of the Installing and configuring security system components guide). If the Sensor is disarmed, the "Closed" / "Opened" events appear correspondingly.

Creating, saving and deleting scripts
Creating a script

To create a JScript script in Intellect, the Editor-Debugger utility is used.
To start the utility, click the Editor-Debugger button in the Script object settings panel.

To create a script, do the following:


https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=136250443
https://doc.axxonsoft.com/confluence/display/Int411en/Creating+and+configuring+the+Sensor+system+object
https://doc.axxonsoft.com/confluence/display/Int411en/Creating+and+configuring+the+Sensor+system+object
https://doc.axxonsoft.com/confluence/display/Int411en/Installing+and+configuring+security+system+components+guide

[y

. In the Programming tab of the System Settings window, create a Script object. Enter the identification number and the name for the script.
. Select the time limits for running the script in the Time Zone field (for example, the Always zone).

@ Note
By default, the Never time zone is selected
. In the Computers field, select the computers (kernels) where the script should run.
@ Note
By default, the script will run on all computers. The list shows only the computers registered in the Hardware tab of the System Settings window
. Click the Editor-Debugger button in the bottom of the Script settings panel to open the Editor-Debugger utility.

@ Note

Use the Editor-Debugger utility to create, edit and save scripts in JScript. The text of saved script available to be edited is saved on the setting panel of the Script obj
ect.

. In the Editor-Debugger utility window, open the Script Debug/Edit list and select the Script object to be edited (for example, Script 2).

Ssopz-exe =lolx|

File Wiew Debugand edit Lisk of events Help
PEHDS | 2mms T D

[#- 5cript Messages —Scripe

—Event

Ready [ e i




6. Enter the text of the script in JScript programming language into the Script field.
7. Run the script using a test event. To create a test event, select the Edit test event in the Debug and edit menu. The Test message window will open allowing to set the test
event parameters.

File Wiew Debugand edit Lisk of events Help

»>EIARE | 2mg T T
[ Sctipt Messages — Scripk
El- Seript Debug/Edit
- SEFipE 1
‘- Script 2

x

—SourceType
| MACRO

—Sourceld
| 1
— Sourcedction
| RUM

param | walue

Yes Canicel ;I

-
4 k

Ready [ o A

To run the script using the test event, select Test run in the Debug and Edit menu.

1. Check the script syntax using the interpreter which is built-in into the Editor-Debugger utility. The verification results showing the error and its location will be displayed in the
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debugger window of this script in the Script messages list. Correct the script to eliminate the error and repeat the verification.
Note
See the detailed information about using test events for script debugging in the Script Debugging section
2. After debugging the script using the Editor-Debugger utility, run it with a real event. Check the result. If the result is incorrect, change it and run again.

Script creation is considered complete if it runs correctly.

Saving a script
The Editor-Debugger utility provides two options for saving scripts — in a Script object, or in a text file on the hard drive.
To save the script in the Script object, in the File menu, select Save in the database.

@ Note

The script is automatically saved in the corresponding Script object upon closing the Editor-Debugger utility

To save the script in the file, in the File menu, select Save on disk. To open a script saved in a file in the Editor-Debugger utility, in the File menu, select Open from disk.

Deleting a script

To delete a script created in the Intellect system, delete the corresponding Script object in the Programming tab.

Creating your first script

As an example of using JScript in Intellect, try to create a script for the following tasks: when Macro 1 starts, set the value 10 to the Hot Recording parameter for Cameras N° 1 - 4
and output the Hello world message to the debugger window of the Editor-Debugger utility.

To create and run this script, do the following:

In the Hardware tab of the System Settings window, create four Camera objects with identification numbers 1, 2, 3 and 4, if they have not been created before.
In the Programming tab, create a Macro object with identification number 1. The Events table should not be filled for .

Create a Script object in the Programming tab. Enter the identification number 1 and the name Script 1.

In the Script 1 object settings panel, select Always in the Time zone list.

Click the Editor-Debugger button at the bottom of the Script 1 settings panel. The Editor-Debugger window will open.

In the Editor-Debugger window, open the Script Debug/Edit list and select the Script 2 object.

oukwnE
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Ssoiptz-BXE =lolx|

File “iew Debugand edit List of events Help
»>EHRDE|2ms T T

[ Script Messages —Script

—Event

Ready [ oM &
7. Enter the following in the Script field:

if (Event.SourceType == "MACRO" && Event.Sourceld == "1" &&
Event.Action == "RUN")
{
var ;
for(i=1; i<=4; i=i+1)
{
SetObjectParam("CAM",i,"hot_rec_time","10");
b
DebuglLogString ("Hello world");
b

8. In the File menu, select Save to database to save the script.
9. Create a test event to run the script in debug mode - "MACRO|1|RUN|”. To achieve this, in the Debug and edit menu, select Edit test event; the Test message window will
open. Fill in the fields in the Test message window as shown in figure.



Fopeiope =
File iew Debugand edit  List of events  Help

»EBHDS | 2msT T
[ 3ript Messages Seripk
[ Seript Debug/Edit
-~ 5eripk 1
‘- Seript 2
x
—SourceType
IMACRO
—Sourceld
|1
r— SourceAction
IRLIN
param | walue
I
Yfes Cancel :l
-
1 »
Ready

[ [hoe 4
. To run the script with the test event, select Test run in the Debug and edit menu.
. Open the Script Messages list and select Script 1. The debugger window will open at the right side.

. In the debugger window, find the “Process Event:MACRO|1|RUN|"” line and the following error message: “Src identifier missing: Microsoft JScript compilation error Line:2 Char:6
Error:0 Scode:800a03f2".



Gscptt-exe =18 x|

File Wiew Debug and edit  List of events  Help

BHBE 24 e %P

[=- Script Messages Descripkion I

.- ScrpE 1 Process Event:SCRIPT|1|SETUP|ink_obj_id<1>,5LAVE.slave_id.count <0, flags <>, par

Expected YO OSrc: Microsoft J5cript compilation error 0 OLine:2 Char: 17 Error:0 Scod

End ProcessScript, begin-end delay: 74 [msec]

Process Event:SLAYE |E-RYAZANOWA|REGISTER_USER |int_obj_id<1 =, owner <E-RYAZ64

Expected YO 0OSrc: Microsoft J5cript compilation error 0 OLine:2 Char: 17 Error:0 Scod

End ProcessScript, begin-end delay: 0 [msec]

Process Event: SLAYE |E-RYAZANCYWA | CONNECTED|ink_obj_id <13, 50CKET<10.0.1.50=

Expected WO 0O5rc: Microsoft J5cript compilation error O OLine: 2 Char: 17 Error:0 Scod

End ProcessScript, begin-end delay: 74 [msec]

Pracess Event:SLAYE|E-RYAZANOYA|EXECUTE_COMPLETE|int_obj_id<1 3 slave_id<E-f

Expected WO 0O5rc: Microsoft J5cript compilation error O OLine: 2 Char: 17 Error:0 Scod

End ProcessScript, begin-end delay: 1 [msec]

Process Event:SCRIPT|1]|SETUP|ink_obj_id<1>,5LAVE.slave_id.count <0, flags <>, par

Expected WO 0OS5rc: Microsoft J5cript compilation error 0 OLine: 2 Char: 17 Error:0 Scod

End ProcessScript, begin-end delay: 2 [msec]

Process Event:SCRIPT|1|SETUP|ink_obj_id<1>,5LAVE.slave_id. count <0, flags <>, par

Expected WO OS5rc: Microsoft J5cript compilation error O OLine:2 Char: 17 Error:0 Scod

End ProcessScript, begin-end delay: 1 [msec]

Process Event:MACRO[1JRUNest <1 =, E<25)] ||

Expected WO 0O5rc: Microsoft J5cript compilation error O OLine:2 Char: 17 Error:0 Scod

End ProcessScript, begin-end delay:

I senk:i 1 7RI )]

Expected WO 0O5rc: Microsoft J5cript compilation error O OLine: 2 Char: 17 Error:0 Scod
d ProcessScripk, begin-end delay: 1 [msec]

Process Event:SCRIPT|1]SETUR|ink_obj_id<1>,5LAVE.slave_id.count <0, flags <>, par

Expected YO OS5rc: Microsoft J5cript compilation error O OLine: 2 Char: 17 Error:0 Scod

End ProcessScript, begin-end delay: 1 [msec]

E| SCr

p M|

The error message says that there is no identifier in the second line of variable declaration operator (var). That means no variable has been declared. This is a critical error in
JScript, thus the script has not been executed.
13. Change the text of the script (see the “var i;” line).

if (Event.SourceType == "MACRO" && Event.Sourceld &&

Event.Action == "RUN")
{
vari;
for(i=1; i<=4; i=i+1)
{

SetObjectParam("CAM",i,"hot_rec_time","10");

b
DebuglLogString ("Hello world");

b



14. In the File menu, select Save to database to save the script.

15. Repeat steps 10 and 11.

16. In the debugger window, find the “Process Event:MACRO|1|RUN|” line and the “DebuglLogString:Hello world” and “Script first run OK” messages. The “Script first run OK” means
that the script runs correctly in the debug mode.
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File Wiew Debug and edit  List of events  Help

P>ERHBE|28 &% P
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- SCripk 1 Expected YO 0OSrc: Microsaft J5cript compilation error O OLine: 2 Char: 17 Ervar:0 Se
- Scripk 2 End Processscript, begin-end delay: 1 [msec]
[} Seript Debug/Edit Process Event:MACRO[1JRUMEest <1 5, k<2 ||
Seript 1 Expected YO 0OSrc: Microsaft J5cript compilation error O OLine: 2 Char: 17 Ervar:0 Se
Seript 2 End ProcessScript, begin-end delay: 13861 [msec]

Process Event:MACRO[1JRUNest <1 =, E<25)] ||

Expected WO 0O5rc: Microsoft J5cript compilation error 0 0OLine: 2 Char: 17 Error:0 5o
End ProcessScript, begin-end delay: 1 [msec]

Process Event:SCRIPT|1|SETUP|ink_obj_id<1=,5LAVE.slave_id.count <0=,fags <=,
Expected WO 0O5rc: Microsoft J5cript compilation error O 0OLine: 2 Char: 17 Error:0 5o
End ProcessScript, begin-end delay: 1 [msec]

Process Event:SCRIPT|1|SETUP|ink_obj_id<1=,5LAVE.slave_id.count <0=,fags <=,
Expected identifier O O Src: Microsoft I5cripk compilation error O OLine:2 Char:6 Errc
End ProcessScript, begin-end delay: 1 [msec]

Process Event:SCRIPT|1|SETUP|ink_obj_id<1=,5LAVE.slave_id.count <0=,fags <=,
Expected identifier O O Src: Microsoft 35cripk compilation error O OLine:2 Char:6 Errc
End ProcessScript, begin-end delay: 1 [msec]

Process Event:MACRO[1IRUR| ||

Expected identifier O O Src: Microsoft 35cripk compilation error O OLine:2 Char:6 Errc
End ProcessScript, begin-end delay: 2 [msec]

Process Event:SCRIPT|1|SETUP|ink_obj_id<1=,5LAVE.slave_id.count <0=,fags <=,
Expected identifier O O Src: Microsoft 35cripk compilation error O OLine:2 Char:6 Errc
End ProcessScript, begin-end delay: 1 [msec]

I Process Event: MACRO[I]RUNHI

MEcript First run QK

) H |
Process Event:SCRIPT|1|SETUR|ink_obj_id<1=,5LAVE.slave_id.count <0, fags <=,
Scripk First run G
End ProcessScript, begin-end delay: 1 [msec] —

« | i
[ Ml 4

17. Close the Editor-Debugger utility.

18. The text of the created script will be shown in the Script field of the Script 1 object settings panel. Click the Apply button in the Script 1 settings panel to activate the script.
19. Select Macro 1 in the Run menu of the main control panel.

20. In the debugger window of the Intellect system, check that the macro and the script have run successfully.

React: MOMITOR SET_MARKRECT operators: cam<1: typecdCORMER > id<5x w1 <20 w1437 w2<36 color 16777215 w2044

React: MOMITOR 1 SET_MARKRECT operator<: cam<1> _ slave_id<|-rAR0SLAVDV: wpe<dCORMER > id< B w1 < 20: #1431 2436 colorg
: CORE DO_REALT int_ob_id<1> zlave_id<|YARDSLANVDY: paramy_name<s2s paramb_name<x1 > param_val< 1> paramd_name<pds |
3 E.f-‘n.M 3 HEE STOF int_obi_id< 1, slave Tl Y.&HDSL.&"»-’DW core_global: 1 x awner<| Y.&HDSL.-’-‘-.\-’DW tlme<12 Eld 20> date< 23-04-08:

: STOE it obi id: ] 9.04-03:
s MACHO 1 BUM int obj id<1> core

CMUNITUR T AUTIVATE _LAK int_ab_id< 1> zlave_1d<l-

In:nI:-aI<'I > Lizer ||:|<> u:nwner<| SPAROSLAY DY > tlme<1 2 14: 22> date< 29-04-03
TaRUSLAY N core_global< T cam< 1 owner<[-TAROS LAY > hme<12:04:42

21. Check the accuracy of the script result. The Hot recording field in the Camera 1 to Camera 4 object settings panels should read “10".
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“ideo Capture Device [~ Disable
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Note
(D The Hot recording field in the Camera settings panel is empty by default

Script creation and debugging is now complete.

Script debugging
Script debugging features

The Editor-Debugger utility allows debugging scripts using the built-in tools for checking script syntax, script interpreting and script execution with test events generated by the utility.
The messages about the debugging results are displayed in the corresponding debugger windows.

The Editor-Debugger utility provides the following debugging functionality:

1. A separate debugger window is assigned to each Script object, where the test and system events, error messages, success messages and user information messages are

displayed. The messages in the debugger windows can be filtered.
2. Special Information window debugger windows are available for displaying the messages related to the script being debugged.
3. Test events generated by the Editor-Debugger utility, which are not registered by the Intellect system, are used for checking script accuracy.
4. Third-party debugger programs can be used for step-by-step execution, viewing script variables during execution, and other functionality.

Creating and using test events
Creating test events
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The Editor-Debugger utility is capable of generating test events chosen by the user to help debug the scripts. Test events are not registered by the video surveillance system, i. e. they
are not listed in the events log and not saved to the database.

No more than one test event can be created for each script.

To create a test event, do the following:

1. In the Debug and edit menu, select Edit test event, or click the button in the toolbar.
2. The Test message window will open.



Fopeiope =
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This window is used for entering the test event parameters.
3. Enter the following information in the fields of the Test message window:
a. SourceType - object type;
b. Sourceld - object identification number;
c. SourceAction - the event generated by the specified object;
d. param - additional event parameters;

e. value - values of the additional parameters.
4. Click the OK button.
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The test event is now created.
The created test event will be displayed in the Event field in a special string format.

Figure shows the test event example: "Arm Camera 111”.

[Ssoipz-exe =lolx|

File ‘iew Debugandedit List of events Help

»EEDS[2mis T P

— ScrHpk
if [(Event.SourceType == "HACRO"™ &£& Event.SourcelId & Event.Action == "]
{

; war i;

- Seripk 1 for(i=1; i<=4; i=i+1)

o Seripk 2 f

SetDbjectParam|"CAM", i, "hot_rec time","10"):
i
DebugLogString ("Hello world™):
i

< | i
—Event

(CaM[L][ARM] <) =]

cap o [

Running the script with a test event

To run the script with a test event, do one of the following:

1. Click the Test run ( A ) button in the toolbar.
2. In the Debug and edit menu, select Test run.
3. In the Debug and edit menu, select Test run in third-party debugger.

When the Test run in third-party debugger option is selected, the third-party debugger starts to run the test (see details in the Using third-party debuggers section).

The results of the verification and execution of the script are displayed in the corresponding debugger window of the Editor-Debugger utility.

Using debugger windows of the Editor-Debugger utility



72

Debugger window types: Script Messages and Thread Information

Debugger windows display messages about system and test events, errors and successful script execution, as well as user information messages.

A separate debugger window is assigned to each script in the Editor-Debugger utility.

There are two types of debugger windows: Script Messages and Thread Information.

The names of Script Messages windows are listed in the Script Messages list. The names of the windows match the names of the corresponding Script objects. These windows display

all system messages related to all scripts in the Intellect system.

&% Seript 1 - EXE

File Wiew Debugandedit List of events Help

=10l x|

PEEDE|2E D B

E| S_cript Messages | rScript

- Seripk 1

M Information from stream il == "]
- Scripk 2

- Script Debug(Edit [essa08
- Seripk 1 Process Event:MACRO[TIRUM][|
Seript 2 Scripk First run Ok

End ProcessScript, begin-end delay: 1 [msec]

Ready

E— L

e L.

The Thread Information windows open directly from the script editing windows (named in the

editing window, select Summary information in the Debug and edit menu, or click the
the current script being debugged.

Script Debug/Edit list). To open the Thread Information window from an active script

button in the toolbar. The Thread Information windows display only the events related to
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Ready
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Both types of debugging windows are used in the same way.

Displaying messages about starting, verifying, changing and executing scripts in the debugger windows

The messages in the debugger window track the stages of starting, verification and execution of scripts.

e .

When the event occurs that triggers the script, the following message is displayed in the debugger window: “Process Event: <script triggering event>"; for example, if the script starts
upon Macro 1 execution, the line reads “Process Event:MACRO|1|RUN|".

At the moment of changing the script in Debugger utility or in the Intellect, the debugger window displays the message «Process Event: SCRIPT|script’'s number|SETUP|» (for example,
while changing the script with number 1, the debugger window displays «Process Event: SCRIPT|1|SETUP|»).

Script syntax is checked before execution. In case of syntax errors, related error messages will be displayed in the debugger window. Figure shows an example of a syntax error
message.



Ssoipta-exe ~=lol x|
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Process Event:]]]
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End ProcessSeripk, begin-end delay: 1 [msec]
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Right-click the message to view its complete text. The Information window will open containing the full text of the error message.
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The message contains the following information:

Error description;

Error type (for example, Src: Microsoft Jscript compilation error);

Error location in the script text (line number and character number in the line);
Error code (Scode).

AL

In case no errors were detected, the following message will be displayed in the debugger window: Script first run OK. Then, the script will run.
Script runtime errors are also displayed in the debugger window.

In case of successful execution of the script, the following message will be displayed: “End ProcessScript, begin-end delay: <script execution time>; for example, “End ProcessScript,
begin-end delay: 13 [msec]”.

Using third-party debugger programs
The Intellect software package officially supports debugger Microsoft Visual Studio 2005.

The Intellect software package allows using third-party debuggers for processing JScript scripts. These programs may have the functionality that is not included in the Editor-Debugger
utility, for example, step-by-step script execution, watching script variables during script execution, etc.

(D Note

We do not recommend using third-party debuggers, since they do not provide full compatibility with the Intellect software, and may lead to failure of the Intellect software
We strongly recommend introducing the breakpoint in the script when using third-party debuggers. To insert the breakpoint, add the following line to the script: “debugger;”. The script
execution will pause at this line, and the debugger will start.
When a third-party debugger is used, scripts can be started with test events only.
To start the script using a third-party debugger, do the following:

1. Create the script and insert the “debugger;” line in it.
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2. Create a test event for the script.
3. In the Debug and edit menu, select Test run in third-party debugger.
4. The Just-In-Time Debugging window will open. Select one of the debuggers installed on the computer.

Just-In-Time Debugging

Flease select a debugger.

Possible Debuggers:

Mew instance of Microsaft Script Editar

[~ Set the currently selected debugger as the default,

Do you want ko debug using the selected debugger?

Yes [ie] |

5. Click Yes to confirm the selection.
In case of a successful syntax check (no errors found before the “debugger;” line), the third-party debugger will start. The script will pause at the breakpoint.

Example. A script with the use of the breakpoint when Macro 1 starts.

if (Event.SourceType== "MACRO" && Event.Sourceld=="1" && Event.Action == "RUN"); //start Macro 1

{
debugger; // breakpoint
DebuglLogString ("Hello world");

b

Examples of scripts in JScript language



On the page:

® Example 1. Visualisation of operating the
Queue length detection in the Video
Surveillance monitor

® Example 2. Visualisation of operating the
People Counter detection in the Video
Surveillance monitor

® Example 3. Setting the text for displaying on
the map

® Example 4. Displaying camera on the
monitor by clicking the button on the remote
control

® Example 5. Sending command to camera
using the camera HTTPAPI

® Example 6. Script for framing abandoned
objects in live video

® Example 7. Using START and STOP events
for Failove

To illustrate available fields of application of scripts in Jscript see the following examples which can be used to create additional functions in the system on the basis of the Script object

Example 1. Visualisation of operating the Queue length detection in the Video Surveillance monitor

The Queue length detection object (is part of the Detector Pack package), Camera and Captioner objects (instead of N, M, L symbols set the corresponding numbers of the Queue
length detection, Camera and Captioner objects) are to be created and configured for correct script working in the Intellect software.

//Event reading by the queue length
if (Event.SourceType == "OCCUPANCY_COUNTER" && Event.Sourceld == "N" && Event.Action == "OCCUPANCY") //N - Number of Queue length
detection

{
var n=Event.GetParam("occupancy");
//Displaying the queue number by the Captioner in the Monitor
DoReactStr("CAM","M","CLEAR_SUBTITLES","title_id<L>"); //M - Number of Camera L - Number of Captioner
DoReactStr("CAM","M","ADD_SUBTITLES","command<Queue length: "+n+" person(s).\r>,page<BEGIN> title_id<L>"); //M, L - the same
b

As a result the text message about the current queue length will be imposed on the video image while displaying the corresponding camera in the Video Surveillance monitor.

Settings of the font, color and position of text is configured on the settings panel of the Captioner object.

Example 2. Visualisation of operating the People Counter detection in the Video Surveillance monitor
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The People Counter Detection object (is part of the Detector Pack package), Camera, Captioner and Macro objects (instead of N, M, L, P symbols set the corresponding numbers
of the People counter detection, Camera, Captioner and Macro objects) are to be created and configured for correct script working in the Intellect software.
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//Event reading and counting of entered people
if (Event.SourceType == "PEOPLE_COUNTER" && Event.Sourceld == "N" && Event.Action == "IN") //N - Number of People Counter detection
{
i = Itv_var("counter_i");
k = Itv_var("counter_k");
i++;
Itv_var("counter_i")=i;
//Displaying the number of people by Captioner in the Monitor

DoReactStr("CAM","M","CLEAR_SUBTITLES","title_id<L>"); //M - Number of Camera L - Number of Captioner
DoReactStr("CAM","M","ADD_SUBTITLES","command<Number of people (entering/exiting): "+i+" / "+k+"\r>,page<BEGIN> title_id<L>"); //M, L -
the same

b
//Event reading and counting of exitng people
if (Event.SourceType == "PEOPLE_COUNTER" && Event.Sourceld == "N" && Event.Action == "OUT") //N - Number of People Counter detection
{
i = Itv_var("counter_i");
k = Itv_var("counter_k");
k++;
Itv_var("counter_k")=k;
//Displaying the number of people by Captioner in the Monitor

DoReactStr("CAM","M","CLEAR_SUBTITLES","title_id<L>"); //M - Number of Camera L - Number of Captioner
DoReactStr("CAM","M","ADD_SUBTITLES","command<Number of people (entering/exiting): "+i+" / "+k+"\r>,page<BEGIN>,title_id<L>"); //M, L -
the same
b
//Null the counter by Macro (previously the Macro is to be created in the Intellect)
if (Event.SourceType == "MACRO" && Event.Sourceld == "P" && Event.Action == "RUN") //P - Number of Macro
{
Itv_var("counter_i")=0;
Itv_var("counter_k")=0;
i=0;
k=0;
//Displaying number of people by Captioner in the Monitor

DoReactStr("CAM","M","CLEAR_SUBTITLES","title_id<L>"); //M - Number of Camera L - Number of Captioner
DoReactStr("CAM","M","ADD_SUBTITLES","command<Number of people (entering/exiting): "+i+" / "+k+"\r>,page<BEGIN> title_id<L>"); //M, L -
the same

b
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As a result the text message about number of entering and exiting people will be imposed on the video image while displaying the corresponding camera in the Video Surveillance
monitor.

Settings of the font, color and position of text is configured on the settings panel of the Captioner object (see the Configuring captions display on a video image section of the Administ
rator’s Guide document).

Previously create the Macro object on the Programming tab to null the counter of visitors. The name of the object can be changed to “"Null of people counter” for ease of using.

Macro of setting to zero can be run manually by main menu of the Intellect software package or automatically in any specified time (use the Events table on the settings panel of the M
acro object where the previously configured Time zone object is to be specified). Detailed information about using the Macro and Time zone objects is given in the Administrator's
Guide document).

Example 3. Setting the text for displaying on the map

It is possible to select the type of Text displaying while attaching object to the map (see Administrator Guide, the Attaching objects to the layers of interactive map section). Also the
script on the JScript language can be used for changing the displayed text.

Example. The Text type of display on the map is selected for the Camera 1. It's required to display value of the MyVar value read from the C:\test.ini file on the map and debug window
while processing the Macro 1.

if(Event.SourceType == "MACRO" && Event.Action == "RUN")
{

var result = parselnt(ReadIni("MyVar","C:\\test.ini"));

result += 2;

NotifyEventStr("CAM","1","ANALOG_PARAMS","text<Variable value = \n" + result + ">, blink_state<1>");
DebuglLogString(result);
b

Example 4. Displaying camera on the monitor by clicking the button on the remote control

The following example is valid only for cameras in configuration of which there is PTZ control panel. When configuring Video surveillance monitor select the Go to preset action with
1,2,3...,0 parameters for ten joystick buttons (see Assigning commands to joystick buttons using the Monitor section of Installing and configuring security system components guide).
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Example. When the button is clicked on the control panel, display corresponding camera in the active monitor. The script is to timer trigger with ID=1.

Note.
The Timer object is to be created and configured beforehand and the current year is to be set. Information on how to configure the Timer object can be found in Creating and
configuring the Timer object section of Administrator's Guide

After each button click on the control panel wait for 2 seconds until clicking another button. If there is no button click, then the camera with dialed number is to be displayed.


https://doc.axxonsoft.com/confluence/display/Int411en/Creating+and+configuring+the+Timer+object
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if (Event.SourceType=="TIMER" && Event.Sourceld=="1" && Event.Action=="TRIGGER")
{

mon:lllll;

DebuglLogString("on monitor "+ Itv_var("cam"));
DoReactStr("MONITOR",mon,"ACTIVATE_CAM","cam<"+Itv_var("cam")+">");
Itv_var("cam")="";

b

if (Event.GetParam("source_type")=="TELEMETRY" && Event.GetParam("action")=="GO_PRESET")

{
DoReactStr("TIMER","1","START","bound<2>");

var key=Event.GetParam("param4_val");
DebuglLogString("Key:"+key);
Itv_var("cam")=Itv_var("cam")+key;
DebuglLogString(Itv_var("cam"));

Example 5. Sending command to camera using the camera HTTPAPI

Example. Camera IP address is 192.168.0.13.

The command enables the camera wiper:
192.168.10.101/httpapi/SendPTZ?action=sendptz&PTZ_PRESETSET=85
The command disables the camera wiper:
192.168.10.101/httpapi/SendPTZ?action=sendptz&PTZ_PRESETSET=86

These commands are to be sent to camera using the Jscript script.
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function DoPreset(preset)

{
xmlhttp=new ActiveXObject("MSXML2.XMLHTTP");
if(xmlhttp == null)
{
return;
b
xmlhttp.open("GET", "http://192.168.0.13/httpapi/SendPTZ?action=sendptz&PTZ_PRESETSET="+preset, false,"admin","1234");
xmlhttp.send();
DebuglLogString(xmlhttp.status);
b
if (Event.SourceType == "MACRO" && Event.Sourceld == "6" && Event.Action == "RUN")
{
DoPreset("85");
b
if (Event.SourceType == "MACRO" && Event.Sourceld == "7" && Event.Action == "RUN")
{
DoPreset("86");
b

Example 6. Script for framing abandoned objects in live video

If the object tracking function is in use (see Creating and configuring the Timer object section of Administrator's Guide), then detected objects will be framed in video when viewing the
archive. To frame abandoned objects in live video use the script aimed to frame an abandoned object when receiving alarm from VMDA detection tool:


https://doc.axxonsoft.com/confluence/display/Int411en/Creating+and+configuring+the+Timer+object
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=136250443
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if (Event.SourceType=="CAM_VMDA_DETECTOR")
{
cam=GetObjectParentld("CAM_VMDA_DETECTOR",Event.Sourceld,"CAM");
if (Event.Action=="ALARM")
{
var x1,x2,y1,y2;
x1=Event.GetParam("x");
x2=Event.GetParam("w");
yl=Event.GetParam("y");
y2=Event.GetParam("h");
x2=parselnt(x1)+parselnt(x2);
y2=parselnt(yl)+parselnt(y2);
DoReactStr("MONITOR","","SET_MARKRECT","cam<"+cam+">,color<255>,id<"+cam+"> ,x1<"+x1+"> x2<"+x2+">,y1<"+y1+">,y2<"+y2+">");
DebuglLogString("x1:"+x1+" x2:"+x2+" y1:"+y1+" y2:"+y2);
b
else
{
DoReactStr("MONITOR","","DEL_MARKRECT","cam<"+cam+">,id<"+cam+">");
b
b

Example 7. Using START and STOP events for Failove

Objects from more than one main Server are not to be moved to the Backup Server. For this when moving objects from some main Server to the Backup Server all other Failover obje
cts are to be disabled on this Backup Server.
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if (Event.SourceType == "FAILOVER")
{
if (Event.Action == "START") {action="DISABLE";}
if (Event.Action == "STOP") {action="ENABLE";}
id=Event.Sourceld;
msg=CreateMsg();
msg.StringToMsg(GetObjectlds("FAILOVER"));
var
objCount=msg.GetParam("id.count");
for (i=0;i<objCount;i++)
{
pid=msg.GetParam("id."+i);

if (1(id==pid)) {
DoReactStr("FAILOVER",pid,action,"");

b
b
b

Programming Guide (JScript). Conclusion

More detailed information on the Intellect software package is presented in the documents titled:

1. Installing and configuring security system components guide;
2. Operator’s Guide;
3. Administrator’s Guide.

If while operating the given software product you have faced difficulties and problems, you are welcome to contact us. However before addressing us, we kindly ask you to answer the
following questions:

1. What is the problem?
2. When did the problem occurr and what had happened before it occurred?
3. Which conditions gave rise to the problem?

Remember, that the more detailed and precise information you give us, the faster our experts will resolve your problem.
We are striving to improve the quality of our products, and hence welcome any proposals and suggestions how to improve our software and documentation.

Please forward your suggestions to the following e-mail addresses: documentation@axxonsoft.com

Appendix 1. Description of the Editor-Debugger utility
The purpose of the Editor-Debugger utility


https://doc.axxonsoft.com/confluence/display/Int490en/Installing+and+configuring+security+system+components+guide
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=86474942
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=84354171

The Editor-Debugger utility is designed for creating, debugging and editing scripts in the Intellect software package.
The Editor-Debugger utility provides the following functionality:

Creating and editing scripts using the built-in text editor;
Debugging scripts using the built-in debugger window;

Filtering the information to be displayed in the debugger window;
Creating and using test events for debugging;

Saving scripts to the hard drive;

. Opening scripts from the hard drive.

The interface of the Editor-Debugger utility
The Editor-Debugger window

QUAWN

The Editor-Debugger window contains the main menu, the toolbar (1), the object list (2) and the viewing/editing panel (3).

=lalx|
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T (Event.SourceType == "MACRO" £& Event.Sourceld && Eventlﬁ

var 1i:
for(i=1; i<=4; i=i+1)
{
SetObjectParam|"CLHM", i, "hot rec time™, "10"):
¥
DebugLogString ("Hello world™):

2

cap um [ 4

The Script Debug/Edit tab
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Description of the Script Debug/Edit tab

The Script Debug/Edit tab is used for editing scripts and creating test events.

Figure shows the Script Debug/Edit panel.
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Table shows the description of the elements in the Script Debug/Edit panel.
N2 Field name Field Description Units Default Value
type value range

1  Settings message Auto  Script object Latin, Cyrillicand - -
initialization information special symbols
2  Additional information Auto Additional information Latin, Cyrillicand - -

about scripts special symbols

The Script object panel in the Script Debug/Edit tab



The Script objects in the Script Debug/Edit tab are used for creating and editing scripts and test events.

Figure shows the Script object panel.
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Table describes the elements in the Script object.

N2 Field Field type Description Units Default Value
name value range

1  Script Text field The text Latin, Cyrillic and Empty Unlimited number
of the script special symbols of characters

2 Event Text field Event description Latin, Cyrillic and Empty Unlimited number

in the line format special symbols of characters

The Script Messages tab



Description of the Script Messages tab

The Script Messages tab is

used to display the debugger windows for the scripts.

Figure shows the Script Messages panel.

£X Script Messages - EXE = |E||i|

File Miews Debugand edit  List of events  Help

»EHBE|2wiF T

-

ffS—ettings message A

—

=
SCRIPT|3|SETUR|int_obj_id<3=,5LAVE. slave_id.count <02, Hags < =, parent_id<=,tvpe<i=,sci
{

var ;
forii=1; iO0=4; i=i+1)

1
SetobjectParami"CAM",i, "hok_rec_time","10");
Debuglogstring ("Hello world"});

=,objname<Scripk 3=, name <Scripk 33, time_zone <>

>
SCRIPT|1|SETUP|int_obj_id<1=,5LAVE.slave_id.count <0, Hags <=, parent_id<>,tvpe<0=,sci
{

o J

—

var ;
forii=1; i0=4; i=i+1)

-

.

~

Quantity of streams: I il

Quantity of unprocess message: I 0

Priority of process I MORMAL_PRIORITY _CLASS

4

CAP UM v
Table shows the description of the elements in the Script Messages panel.
Neo Field name Field Description Units Default Value
type value range
1  Settings message Auto  Script object initialization = Latin, Cyrillic and - -
information special symbols
2  Additional information Auto Additional information Latin, Cyrillicand - -
about scripts special symbols

The Script object panel in the Script Messages tab
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The Script panels in the Script Messages tab are used to display system, test and user events related to the scripts created in Intellect.

Figure shows the Script object panel.
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Table describes the elements in the Script object.

N2 rield Na Field Description Units Default Value
me type value range

1  Description Auto Information about the Latin, Cyrillic  Unspecified By default 200 lines are displayed in the list. The value can be changed using the DebugMaxLines registry key (see Regis
events and try keys reference guide).

occurring in the system  special
symbols

Main menu


https://doc.axxonsoft.com/confluence/display/Int490en/Registry+keys+reference+guide
https://doc.axxonsoft.com/confluence/display/Int490en/Registry+keys+reference+guide

On the page:

Description of the main menu

The elements in the File menu

The elements in the View menu

The elements of the Debug and edit menu
The Message list menu elements

Description of the main menu

The Editor-Debugger main menu is used to call editing, debugging and other commands. The commands are grouped into functional menus: File, View, Debug and edit, Message
list and Help.

Table describes the elements of the main menu.

N2 Element name Element Description Units Default Value
type value range
1 File Drop-down Commands for opening - -

list of items and saving scripts and
closing the utility
2  View Drop-down Commands for displaying the - - -
list of items toolbar and the status
bar in the utility window
3 Debug and Edit Drop-down Commands for script - - -
list of items debugging
4  Message list Drop-down Commands for changing - - -
list of items the message display parameters
in the debugger windows
5 Help Drop-down The About command showing - - -
list of items general information about

the Editor-Debugger utility.

The elements in the File menu
The File menu is used to open and save scripts and to close the utility.

Table describes the elements of the File menu.



No. Element Element Description Units Default Value
name type value range
1 Save to database Item Saves the script - - -
in the object
2 Save to disk Item Saves the script into
a text file on the hard drive
3 Open from disk Item Opens the script file - - -
4 Exit Item Shuts down the utility - - -

and closes the window

The elements in the View menu

The View menu contains commands for showing and hiding the toolbar and the status bar.

Table describes the elements of the View menu.

N2 Element Element Description Units Default Value
name type value range
1 Toolbar Checkbox Shows or hides Boolean Checked Check - show toolbar
the toolbar Uncheck - hide toolbar

2  Status bar Checkbox Shows or hides Boolean Checked Check - show status bar

the status bar Uncheck - hide status bar

The elements of the Debug and edit menu

The Debug and edit menu contains the commands for debugging scripts.

Table describes the elements of the Debug and edit menu.

N2 Element Element Description Units Default Value
name type value range
1 Testrun Item Runs the script with the test event - - -
2 Testrun Item Runs the script using the - - -
in third-party third-party debugger
debugger

3 Edit test event Item Opens the window for editing test events - - -
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4  Summary Item Opens the Thread Information - - -
information window showing system, test and user
messages related to the current script

5 Go to line Item Opens the window for entering the script - - -

line and character number to go to

The Message list menu elements

The Message list menu contains commands for changing the message display parameters in the debugger window.

Table describes the elements of the Message list menu.

N2 Element Element Description Units Default Value
name type value range
1 Clear Item Clears the Description field - -

in the debugger window
2  Colors Item Opens the window allowing to - - -
specify the words that a line should
contain to be highlighted in color
3 Search Item Searches for a word in the Description window

4 Set filter Item Opens the window allowing to set the filtering - - -
criteria for the messages in the debugger window.

5 Apply filter Item Applies the current filter - - -

The Filter dialog window
The Filter window allows to set the filtering criteria for the messages displayed in the Description field of the debugger window.
To open the Filter window, do one of the following:

1. Click the Edit test message ( b ) button in the Editor-Debugger toolbar.

2. In the Debug and edit menu, select Edit test message.

Figure shows the Filter window.
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Table describes the elements in the Filter window.

N2 Element Element Description Units Default Value
name type value range

1 Include Text field Only the lines containing the Latin, Cyrillic and Empty Unlimited number
words from this field will be special symbols of characters

displayed in the debugger window
2 Exclude Text field The lines containing the words from Latin, Cyrillic and Empty Unlimited number
this field will not be displayed special symbols of characters

in the debugger window

The Color dialog window

The Color dialog window is used for setting up color highlighting of the lines containing certain words.

To open the Color window, do one of the following:



1]
1. Click the Colors ( - ) button in the Editor-Debugger toolbar.
2. In the Message list menu, select Colors.

Figure shows the Color window.
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Table describes the elements in the Color window.

N2 Element Element Description Units Default Value
name type value range
1 Words Text field Contains the words or any sequences Latin, Cyrillic Empty  Unlimited number
of characters, that make the line and special symbols of characters

containing one of them, highlighted.
2 Color Drop-down The color for highlighting the lines RGB format Grey RGB colors

list



The toolbar of the Editor-Debugger utility

The Editor-Debugger toolbar is used for calling frequently used functions of the utility.
The toolbar operates in two modes: when the script control buttons are active, or when the debugger window control buttons are active.

The mode depends on the currently active tab of the Editor-Debugger utility: either the Script Debug/Edit tab for editing scripts, or the Script Messages tab for viewing messages in
the debugger window.

Figure shows the toolbar in the script editing mode.
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Table shows the elements of the toolbar in the script editing mode.
Neo Element Element Description Units Default Value
name type value range

1 Testrun Button Runs the script with the test event - - -

96
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Test run in third-party

debugger

Save

Edit test event

Summary information

Button Runs the script using the third-party debugger -

Button Saves the script to the Script object -

Button Opens the window for editing test events -

Button Opens the Thread Information window that displays -
system, test and user messages related

to the current script

Figure shows the toolbar in the script debugging mode.
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Table shows elements of the toolbar in the script debugging mode.
N2 Element Element Description Units Default Value
name type value range
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1 Clear Button Clears the Description field in the debugger window - -

2  Colors Button Opens the window allowing to specify the words that - - -
a line should contain to be highlighted in color

3  Search Button Searches for a word in the Description window - - -

4  Set filter Button Opens the window allowing to set the filtering criteria - - -
for the messages in the debugger window.

5 Apply filter Button Applies the current filter - - -

Appendix 2. Creating virtual objects with ability to set events,
reactions and states
Purpose of virtual objects and their implementation in Intellect

Virtual objects represent software emulation of new Intellect objects and allow configuring their states, reactions and events. Virtual objects are handled using scripts, macrocommands
and macroevents.

Virtual objects are created using the ddi.exe and CustomTypeEditor.exe utilities in the <Intellect installation folder>\Tools.

In the How to create a virtual object section you can find an example of creating 2 types of virtual objects that can be used to show the state of abandoned object detection tool on the
map or to show any other user states. The states of objects are changed using macros, scripts or via IIDK.

How to create a virtual object

Here one can find out how to create the following virtual objects:

1. CUSTOM type with SLAVE (Computer) parent type.
2. CUSTOM_CHILD type with CUSTOM parent type (see item 1).

An object of the CUSTOM type has the property set:

Custom_param1 and custom_param2 parameters
Events: ALARM, INFO, ON, OFF
Reactions: ON, OFF
States: ON, OFF
State machine:
a. Set ON state for ON event
b. Set OFF state for OFF event

uhwn e

The CUSTOM_CHILD type of the object is created to demonstrate tree structure and has no user parameters, events, reactions or states.
dbi file preparation

A dbi file is prepared using the ddi.exe utility. Details on how to handle it can be found in the The ddi.exe utility for editing database templates and external settings files section of Adm
inistrator's Guide.


https://doc.axxonsoft.com/confluence/display/Int411en/The+ddi.exe+utility+for+editing+database+templates+and+external+settings+files
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=124980307
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=124980307

A dbi file for objects of CUSTOM and CUSTOM_CHILD type is created as follows:

1. Run dbi.exe (see The ddi.exe utility for editing database templates and external settings files).
2. Go to the DBI tab.

3. Create two objects - OBJ_CUSTOM and OBJ_CUSTOM_CHILD - as shown in the figure below.

1 Important!
Object (table) names should look like OBJ_<object type>.

[Coorapmeerr =
File

Field name Type Size [

id CHAR * |16

name CHAR T |60

parent_id CHAR - |16

flags INTEGER >

quid UNIGQUEIDENTI... =

custom_param1 TEXT -

custom_param? INTEGER =

[OBJ_CUSTOM]

id, CHAR, 16

name, CHAR, 60
parent_id, CHAR, 16

flags, INTEGER

guid, UNIGUEIDENTIFIER
custom_param1, TEXT
custom_param?Z, INTEGER

Total objects: 2

Note.
Id, name, parent_id, flags and guid parameters are mandatory for all objects. Custom_param1 and custom_param?2 are user parameters.

4. Save changes using the Save command in the File menu. The saved file must have dbi extension and must be located in Intellect installation directory - C:\Program Files
(x86)\Intellect\intellect.custom.dbi

dbi file preparation is complete.

ddi file preparation

A ddi file is prepared using the ddi.exe utility. Details on how to handle it can be found in the The ddi.exe utility for editing database templates and external settings files section of Ad
ministrator's Guide.

A ddi file for CUSTOM and CUSTOM_CHILD object types is created as follows:

1. Run ddi.exe (see The ddi.exe utility for editing database templates and external settings files).
2. Create CUSTOM and CUSTOM_CHILD objects in the DDI tab as shown below.


https://doc.axxonsoft.com/confluence/display/Int411en/The+ddi.exe+utility+for+editing+database+templates+and+external+settings+files
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https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=124980307
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¢ orapareaore =
File
ool | DBl | Names | Events | Reactions | lcons | States | Transfernies |
5 |
CUSTOM_CHILD Search by name
Object | Name | Group name
» CUSTOM
CUSTOM_CHILD Child virtual object
Total objects: 2
3. Go to the Events tab and configure events that are to be supported by the object (see the figure).
: DDI & DBI Editor * B =131 x|
File
DDl IDEI I "Names Everts Iﬂaadlons | lcons I States | Transfer ules I
CUSTOM Disable )
CUSTOM_CHILD P Teeroe rf":sf;’f fudo sgpar | etk g‘:;'j"; Windows log
H [ u ]
Evertifo | INFORM... [ ] ] ] ]
ON Enabled - r r r r
OFF Disabled - r r O O
b - r r r r
| Parameter | Name | Type Element | Value

Total objects: 2

4. Go to the Reactions tab and configure reactions that are to be supported by the object (see the figure).

Note.
Reactions of virtual objects are automatically converted into events. In other words, a virtual object automatically generates an event when there is a reaction.

100



: DDI & DBI Editor *
File

_iolx
Dol IDBI I " Mames | Events Reactions | lcons I Statal Transfer ru\ml
CUSTOM Reaction Description Aming region
CUSTOM_CHILD on Enable r

§ |OFF Disable r

* r

| Parameter | Name | Type Element | Value
* | | _

Total objects: 2

5. Go to the States tab and describe the states that the object can take. Here there are two states - ON and OFF.

: DDI & DBI Editor *
File

10| x|
DoI IDEI | " Names | Everts | Reactions | lcons  States ITransferru\eal
CUSTOM CHILD Netps image Descrption Blinking on alam

2 ON on Enabled ]

OFF off Disabled [

- — :

Total objects: 2

Note.

The postfix of file name is specified in the Image column - the image that is stored in < Intellect installation directory>\Bmp. For instance, these will be
custom_off.bmp and custom_on.bmp files (corresponding to ON and OFF states) for CUSTOM object. These files will be used by the map module.
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Go to the Transition rules tab and set the object state change logic.
> DDI & DBI Editor *

File

o =] 3]
Dol IDE" | " Names | Everts | Reactions | lcons | States  Transfernies |
CUSTOM = et T
CUSTOM_CHILD 5 . = m .
QFF ° - | oFF =
* E = =

Total objects: 2

Transition rules is a simple state machine - an event is an input action and a state is a result.

An unconditional transition is used in this case: if CUSTOM||ON event is received, then there is transition to the ON state, if CUSTOM||OFF event is received, then there is
transition to the OFF state.
7.

To save changes use the Save command in the File menu. The saved file must have the ddi extension and be stored in the folder corresponding to the required language, e.g.
C:\Program Files (x86)\Intellect\Languages\en\intellect.custom.ddi
The ddi file preparation is completed.

XML file preparation

An XML file is prepared using the CustomTypeEditor.exe utility that can be found in <Intellect installation directory>\Tools. The utility overview is shown below.

~iix
File
object_type | parent_type | has_child

An XML file for a virtual object is created as follows:

1. Specify the name of object type in the object_type field (1).
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ISI=

File

object_type parent_type has_child
CUSTOM SLAVE [

CUSTOM_CHILD JCUSTOM

Specify the name of parent type in the parent_type field (2).

If the object type has child types, then set the has_child checkbox checked (3).

Repeat steps 1-3 for all object types.

Save a file with any name in the Intellect installation directory using the File - Save command.

auhPhwWN

The XML file is now created. The file contents look like this:
<?xml version="1.0" standalone="yes"?>
<objects>

<object>
<object_type>CUSTOM</object_type>
<parent_type>SLAVE</parent_type>
<has_child>1</has_child>

</object>

<object>
<object_type>CUSTOM_CHILD</object_type>
<parent_type>CUSTOM</parent_type>
</object>

</objects>

Modify it manually if required.

Creating and using a virtual object in Intellect
On the page:

® Showing on the map

® Using in macros

® Sample program in Jscript to change virtual
object state
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When dbi, ddi and XML files are ready objects of a new type along with standard objects can be created in Intellect hardware tree.

Hardware Programming

Alarm Message Window
Archive

ATM

Audio card

|Z] Change parameter...

Expand tree

Collapse tree Data replication service

Event counter

*

Camera discovery tool External storage

Failower

IIDK Interface
Intercom Subsystem
Keyboard

LDAP service

Delete object

Create folder...

[ [ 4 TH 0w | e

Save
Find...

=
=

Long-term archive

Send to all Long-term audio archive

Load configuration. .. Mail Message Service
Operator query pane
PANEL

Playback card

PS-RTP Server

risp Server

RUBEG

Short Message Service
SNMP Objects

Sound notification

QY o Ve Ok a

Save configuration. ..

©@FL = b B Rk Z N lkE

System restart service

Telemetry Controller

(&

Video capture device
Videogate

virtual object

VMDA metadata storage
Voice Message Service

Voice notification service
Web-server
Web server 2.0

0 @&y ofee u

Computer

User parameters are displayed on the settings panel of the created virtual object — custom_param1 and custom_param?2 in this example. Their values can be set in the table.

104



Architecture Hardware ntefaces Programming

=I5 LOCALHOST [S-UYUTOVA] custom_param1
T device 1[1] i [Virtual obiect 1 e
[ Jvirtual object 1 (1] Computer I~ Disable
LOCALHOST =

Cancel

Showing on the map
When an object is created in the hardware tree it can be placed on the map and set reactions can be executed in the object context menu (see Configuring the interactive map for
object state indication and controlling the objects).

Virtual ohject 1[1]

Enable
Disable

Using in macros

When a virtual object is created in the hardware tree it can be used in macros.
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2 Macro 2
[~ Disable
 Settingsz
State | - ™ Local I” Hidden

Events Farameters

Type | Mu... | M amne | Ewent I arne | W alue |

tacro 1 Macro 1 Action executed

1] | 2]

Actiohs Parameters

Type | M. | Mame | Action Marne | Walue

Yirtual object 1 Wirtual object 1 Enable

Kl | 2l

Apphy Cancel

Note.
(D Reactions of virtual objects are automatically converted into events. Thus, in the sample when ON reaction is executed the object state changes thanks to set state transition
rules (see ddi file preparation) and the icon corresponding to the state will be shown on the map.

Sample program in Jscript to change virtual object state

Problem. Using macro 1 change a state of virtual object 1 to ON and show the icon corresponding to this state on the map.
Solution. As state transition rules are set, when ON event is sent from the virtual object the state will be automatically changed to ON and the icon specified in ddi file (see ddi file
preparation) to this state will be shown on the map. A script for sending ON event looks like this:
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if (Event.SourceType == "MACRO" && Event.Sourceld == "1" && Event.Action == "RUN")
{

var msgevent = CreateMsg();

msgevent.SourceType = "CUSTOM";

msgevent.Sourceld = "1";

msgevent.Action = "ON";

NotifyEvent(msgevent);
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